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ASCII Table

American Standard Code for Information Interchange (ASCII).    The ASCII code is a product of the 
American National Standards Institute (ANSI), where it is referred to as ANSI Standard X3.4-1977 
(Revised 1983), Code for Information Interchange.    There are two other, virtually identical standards from
other world standards organizations: the 7-Bit Coded Character Set for Information Processing (standard 
number 646) of the International Standards Organization (ISO) and Alphabet No. 5 of the International 
Consultative Committe for Telephone and Telegraph (CCITT).

ASCII is a 7 bit code, so the 128 positions from 128 to 255 are not defined.    MS-DOS    has 8 bit 
character sets called Character Set Code Pages defined to support other languages.    These are 
typically ASCII plus defined characters for 128 to 255.

ASCII Table

Symbol Meaning                                                                                Decimal Hexadecimal    Binary

NUL Do-nothing (Ctrl-@) 0 00 0000 0000
SOH Start of Header (Ctrl-A)            1 01 0000 0001
STX Start of Text (Ctrl-B) 2 02 0000 0010
ETX End of Text (Ctrl-C) 3 03 0000 0011
EOT End of Transmission (Ctrl-D) 4 04 0000 0100
ENQ Enquiry (Ctrl-E) 5 05 0000 0101
ACK Acknowldge (Ctrl-F) 6 06 0000 0110
BEL Bell (Ctrl-G) 7 07 0000 0111
BS Backspace (Ctrl-H) 8 08 0000 1000
HT Horizontal Tab (Ctrl-I) 9 08 0000 1001
LF Line Feed (Ctrl-J) 10 0A 0000 1010
VT Vertical Tab (Ctrl-K) 11 0B 0000 1011
FF Form Feed (Ctrl-L) 12 0C 0000 1100
CR Carriage Return (Ctrl-M)      13 0D 0000 1101
SO Shift Out (Ctrl-N) 14 0E 0000 1110
SI Shift In (Ctrl-O) 15 0F 0000 1111
DLE Data Link Escape (Ctrl-P) 16 10 0001 0000
DC1 Device Control 1 (Ctrl-Q)    17 11 0001 0001
DC2 Device Control 2 (Ctrl-R)      18 12 0001 0010
DC3 Device Control 3 (Ctrl-S)      19 13 0001 0011
DC4 Device Control 4 (Ctrl-T)        20 14 0001 0100
NAK Negative Acknowledge (Ctrl-U) 21 15 0001 0101
SYN Synchronous Idle (Ctrl-V) 22 16 0001 0110
ETB End of Transmission Block (Ctrl-W) 23 17 0001 0111
CAN Cancel (Ctrl-X) 24 18 0001 1000
EM End of Medium (Ctrl-Y) 25 19 0001 1001
SUB Substitute (Ctrl-Z) 26 1A 0001 1010
ESC Escape (Ctrl-[), Control Code Extension    27 1B 0001 1011
FS File Separator (Ctrl-\) 28 1C 0001 1100
GS Group Separator (Ctrl-])            29 1D 0001 1101
RS Record Separator (Ctrl-^)      30 1E 0001 1110
US Unit Separator (Ctrl-_) 31 1F 0001 1111
SP Space 32 20 0010 0000
! Exclamation Point 33 21 0010 0001
" Quotation Mark, Diaeresis (umlaut) 34 22 0010 0010
# Ordinal Number or 1st Currency Symbol 35 23 0010 0011
$ Dollar Sign or 2nd Currency Symbol 36 24 0010 0100



% Percentage Sign 37 25 0010 0101
& Ampersand 38 26 0010 0110
' Apostrophe, Acute Accent 39 27 0010 0111
( Left Parenthesis    40 28 0010 1000
) Right Parenthesis 41 29 0010 1001
* Asterix 42 2A 0010 1010
+ Plus Sign 43 2B 0010 1011
, Comma, Cedilla      44 2C 0010 1100
- Minus Sign 45 2D 0010 1101
. Period 46 2E 0010 1110
/ Forward Slash 47 2F 0010 1111
0 48 30 0011 0000
1 49 31 0011 0001
2 50 32 0011 0010
3 51 33 0011 0011
4 52 34 0011 0100
5 53 35 0011 0101
6 54 36 0011 0110
7 55 37 0011 0111
8 56 38 0011 1000
9 57 39 0011 1001
: Colon 58 3A 0011 1010
; Semicolon 59 3B 0011 1011
< Less Than Sign 60 3C 0011 1100
= Equal Sign 61 3D 0011 1101
> Greater Than Sign 62 3E 0011 1110
? Question Mark 63 3F 0011 1111
@ Commercial At 64 40 0100 0000
A 65 41 0100 0001
B 66 42 0100 0010
C 67 43 0100 0011
D 68 44 0100 0100
E 69 45 0100 0101
F 70 46 0100 0110
G 71 47 0100 0111
H 72 48 0100 1000
I 73 49 0100 1001
J 74 4A 0100 1010
K 75 4B 0100 1011
L 76 4C 0100 1100
M 77 4D 0100 1101
N 78 4E 0100 1110
O 79 4F 0100 1111
P 80 50 0101 0000
Q 81 51 0101 0001
R 82 52 0101 0010
S 83 53 0101 0011
T 84 54 0101 0100
U 85 55 0101 0101
V 86 56 0101 0110
W 87 57 0101 0111
X 88 58 0101 1000
Y 89 59 0101 1001
Z 90 5A 0101 1010
[ Left Bracket 91 5B 0101 1011
\ Backward Slash    92 5C 0101 1100



] Right Bracket 93 5D 0101 1101
^ Circumflex 94 5E 0101 1110
_ Underscore 95 5F 0101 1111
` Opening Single Quotation, Grave Accent    96 60 0110 0000
a 97 61 0110 0001
b 98 62 0110 0010
c 99 63 0110 0011
d 100 64 0110 0100
e 101 65 0110 0101
f 102 66 0110 0110
g 103 67 0110 0111
h 104 68 0110 1000
i 105 69 0110 1001
j 106 6A 0110 1010
k 107 6B 0110 1011
l 108 6C 0110 1100
m 109 6D 0110 1101
n 110 6E 0110 1110
o 111 6F 0110 1111
p 112 70 0111 0000
q 113 71 0111 0001
r 114 72 0111 0010
s 115 73 0111 0011
t 116 74 0111 0100
u 117 75 0111 0101
v 118 76 0111 0110
w 119 77 0111 0111
x 120 78 0111 1000
y 121 79 0111 1001
z 122 7A 0111 1010
{ Left Brace 123 7B 0111 1011
| Vertical Line 124 7C 0111 1100
} Right Brace 125 7D 0111 1101
~ Tilde 126 7E 0111 1110
DEL Delete, Erase Character    127 7F 0111 1111



Buffer
When you work with a document, Editron sets aside an area of memory to hold its text.    These buffers 
are memory copies of disk files.

To work with an existing document, you must read its file into a buffer.    This action opens the document 
in an edit window labeled with the disk file name.    To create a new document, you enter text in a new 
buffer.    The first time you save it, Editron creates a new disk file and asks you to name it.

You can display the same buffer in two or more edit windows at the same time.    Each window works 
with the same underlying buffer.    If you make changes in one window, they appear in the others.



Block Selection
Block selection is the act of highlighting an area of text for further processing.    There are three types of 
blocks: stream, line, and box.

-- Stream blocks extend from one arbitrary point to another, following the text as it wraps across line
breaks.

-- Line blocks consist of complete lines of text, extending from one margin to another.
-- Box blocks are symmetrical squares or rectangles not shaped by the structure of the text.

You can select a block using the mouse, a keystroke command, or the Edit Menu. 

Mouse Operation

To select a stream of text, place the mouse at the first character and click and hold down the left mouse 
button.    Then drag the mouse to the last character in the block and release the button.

To select a line or several lines of text, move the mouse to the left edge of the edit window just beyond 
the first text column.    Click and hold down the left mouse button.    Then drag the mouse down until you 
reach the last line in the block and release the button. 

To select a box of text, move the mouse pointer to one corner of the box.    Click and hold down the right 
button and drag the mouse diagonally to the opposite corner of the box.    Then release the button.

To select a word of text, move the mouse pointer over it and click with the left button.

Note: This is CUA style block selection wtih a mouse. The non-CUA style requires the additional step of 
closing the selection.

Keystroke Command

To select a stream, move the cursor to the first character and type Control-M.    Then move the cursor to 
the last character.

To select a line or several lines, move the cursor to any column on the first line and type Control-L.    
Then move the cursor to the last line.

To select a box, move the cursor to the first character and type Control-B.    Move the cursor diagonally to 
the opposite corner. 

Typing Control-Y closes the selection and allows you to move the cursor freely without changing the 
selection.

Menu Command

To select a stream, move the cursor to the first character and choose the Stream option on the Blocks 
Menu.    Then move the cursor to the last character in the stream.

To select a line or several lines, move the cursor to any column on the first line and choose the Line 
option on the Blocks Menu.    Then move the cursor to the last line in the block.

To select a box, move the cursor to the first character and choose the Box option on the Blocks Menu 
item Line.    Then move the cursor diagonally to the opposite corner of the box.

The Close Opened Selection on the Blocks Menu closes the selection and allows you to move the cursor 
freely without changing the selection.





Code Page
There are three types of character sets; the Original Equipment Manufacturer (OEM) code page, the 
American National Standards Institute (ANSI) code page, and Unicode.

The OEM character set is the generic name for any of the various MS-DOS code pages.    These code 
pages were originally proprietary read-only memory (ROM) based character sets.    They generally cover 
more than one language, even though their names indicate support for only one language, and all contain
ASCII as a subset.    Generally, MS-DOS and Windows code pages are laid out quite differently in the 
128-255 character position range.    Windows renders the underlying OEM character set, used by the file 
system among others, into the displayed ANSI code page.    However it does not supply enough Windows 
fonts for all the OEM code pages it supports. So, even when a full-screen display is correct, a windowed 
MS-DOS session may show some characters incorrectly. The default U.S. code page is number 437.    
MS-DOS can have two code pages loaded simultaneously.

The MS Windows ANSI code page is the one you see most of the time when running Windows.    It is 
based on International Standards Organization (ISO) standard 8859-1, also known as ECMA-94.    ISO-
8859-1 includes several 256-byte character sets for supporting the main languages of the Americas and 
Western and Eastern Europe as well as Arabic, Hebrew, Cyrillic, Greek and Turkish.    ISO 8859-1 is 
commonly called Latin 1. ASCII is a subset of Latin 1. The default Windows ANSI code page conforms 
nearly exactly to Latin 1, also know as Windows code page 1252.    Windows can only run one ANSI code 
page at a time.    

The Unicode Standard, Worldwide Character Encoding Version 1.0, is a product of the Unicode 
Consortium (Unicode, Inc.).    The Unicode character encoding is a fixed-width encoding of 16 bits, which 
provides a sufficient number of unique codes for the world's scripts and technical symbols in common 
use.    Unicode is part of a more general 32-bit encoding standard, ISO 10646-1.    If 10646 is viewed as 
having 32768 planes each containing 65536 characters, then Unicode is equivalent to the first plane, also
known as the Basic Multilingual Plane (BMP). The first 256 characters of Unicode are the same as Latin 
1.    Unicode is the native character set of Microsoft's New Technology (NT) operating system and is also 
used by Novell's NetWare Directory Services (NDS).

Some MS-DOS Code Pages

Code Page Language Group
437 English, French, German, Italian, Dutch
850 W. Europe, Americas, Oceania
852 E. Europe using Roman Letters
855 E. Europe using Cyrillic Letters
857 W. European and Turkish
861 Icelandic
863 Canadian-French
865 Nordic
866 Russian (former USSR)
869 Modern Greek

Some WIndows ANSI Code Pages

Code Page Language Group Windows Supported Languages
1252 W. European  Danish, Dutch, English, Finnish,

using Roman Letters French, German, Icelandic, Italian,
Norwegian, Portuguese, Spanish,
Swedish.

1250 E. Europe Czech, Hungarian, Polish, Slovak



using Roman Letters
1251 E. Europe Russian

using Cyrillic Letters
1253 Greek Greek
1254 Turkish Turkish

Unicode Code Ranges (0x indicates a hexadecimal number)

General Scripts (Latin 1, etc.): starting at 0x0000 position, 2336 characters.
Symbols (Mathematical, etc.): starting at 0x2000 position, 1290 characters.
Chinese, Japanese, Korean phonetic alphabets: starting at 0x3000, 3381 characters
Chinese, Japanese, Korean ideographs: starting at 0x4000, 20733 ideographs.
Private Use Area: starting at 0xE800 and ending at 0xFDFF.
Compatibility Zone (Miscellaneous): starting at 0xFE00 and ending at 0xFFEF.
Special Characters: starting at 0xFFF0 and ending at 0xFFFD.
Non-Unicode: 0xFFFE and 0xFFFF.

The Unicode byte order mark is 0xFEFF.    This can be used with 0xFFFE to indicate whether Unicode 
text is in big-Endian or little-Endian byte storage order. This is usually the first 16 bits of a Unicode file and
indicates the byte order.    For example, the Windows NT Unicode editor Unipad saves its files prefaced 
with the byte order mark.    Thus, a Unipad file having 0xFF and 0xFE as its first two bytes, respectively, 
indicates that it was created on an Intel-based machine.    If it is to be exported to a Motorola processor, 
the byte order mark would signal that the bytes must be reversed before the file can be used.



Compiling And Linking
Before you can compile and link your application you need to configure Editron for your programming 
language.    See Compiler Setup dialog, Linker Setup dialog, and Make Utility Setup dialog.    Select 
these dialogs from the Options menu.    

After the compiler, linker and the make utility are set up, you can run them using the Tool Bar, or the 
Tools Menu, or with a Keystroke.

If any errors occur when running the compiler or make utility, Editron lists them in a compiler results 
window.    To go to an error in your source code, double click on the error in the list.    You can also use the
Next Error or Previous Error commands on the Tool Bar or the Go To Menu.    

See also Editron Concepts.



Compiler Error Formats
The error format tells Editron how to decode your compilers error output.    You can configure these 
formats for your compiler using the Compiler Setup Dialog.    Editron uses six codes to represent the 
parts of an error message:

id The severity of the error.    This code stands for "Error, "Warning, or "Fatal.
sr The name of the file containing the error.
ln The line number of the error.
en The compilers error number.    For example: "C1234" or "1234.
ed The error descriptor.    This code stands for words like "syntax, "lexical, preprocessor, or "fatal.
ms The English description of the error message.
% The code separator. The percent sign precedes each code.

Examples:

Borland C++                                %id%sr%ln%ms
Microsoft C++                            %sr%ln%id%en%ms
Watcom C++                              %id%sr%ln%ms



Context Sensitive SDK Help
You can display the SDK Help page of a Windows function by selecting the function name in your text and
then typing ctrl-<F1>.    See also the sdk_help_keyword command.



CUA
Common User Access.    IBMs guidelines for graphical user interfaces.



Cursor
A cursor shows your position in the text and the mode of text entry.    Each memory buffer has at least 
one cursor.    If there is more than one edit window for a single buffer, each window has its own cursor.



Customizing Editron Per File Extension
You can customize Editron's behavior on a per file extension basis.    Tabs, Tabstops, the right margin, 
compilers, completion of computer language keywords, matching pairs of symbols, these can all be 
customized for each file extension.    The Options menu allows you to access the Tabs Setup dialog, the
Languages Setup dialog and the Compiler Setup dialog.    Working together these three dialogs let you
customize Editron's behavior for a file extension.    In addition, the Setup dialog Smart Language Indent 
toggle needs to be checked in order to allow the completion of computer language keywords, as specified
in the Language Template file.



Drag And Drop Files
You can load files and display their text in an Editron edit window by dragging file icons from the Windows
File Manager.



Drawing a New Buffer And Edit Window
You can create a new buffer without using the File menu.    In a empty area of the Editron window, click 
and hold the left mouse button.    Drag diagonally and release the button when the edit window is the 
correct size.

You can also open a file into a new buffer without using the File menu.    In a empty area of the Editron 
window, click and hold the right mouse button.    Drag diagonally and release the button when the edit 
window is the correct size.    The Open File dialog will appear to prompt you for a file name.



EDITRON.INI

This is Editron's initialization file.    When Editron is invoked it looks in this file to determine how it shall 
initialize itself.    This is a useful place for storing information between editing sessions, and for preserving 
information about the user's preferences.    It is not recommended to change the contents of this file 
manually.

The format of each line within a named section is "name = value".    Sections are preceded by a name in 
square brackets, "[section name]".

General Information
For storing data that affects the overall operation of Editron.    The name and value pairs appear in the 
section labeled [Editron].    Use the Setup or the Advanced Setup dialogs to change most of the 
information located here.

Some specialized configuration information can only be changed by editing a name and value pair inside 
this section.

To change the default extension letters:
          Default_extension=.C

To change whether or not the Editron Logo is displayed on startup:
          EditronLogo=0

To change the default End of File character (value is written in decimal notation):
          EOF_Character=26

To adjust the maximum amount of memory preloaded with text when a file is opened and loaded into a 
buffer (value is written in decimal notation, units are in bytes):
          FilePreloadSize=100000

To adjust the default word delimiter characters when the file name extension is not specifically supported:
          WordsDelimiters=" \t,:;.()[]{}<>*-+' "

Fonts Information
For storing data that affects the Editron system and edit window display fonts.    The name and value pairs
appear in the section labeled [FONTS].    Use the Fonts Setup dialog to change any information located 
here.

Colors Information
For storing data that affects the Editron system and edit window display colors.    The name and value 
pairs appear in the section labeled [Colors].    Use the Colors Setup dialog to change any information 
located here.

SDK Help Information
For storing data about Editron's associated SDK help files.    The name and value pairs appear in the 
section labeled [SDK_Help_Section].    Use the Applications dialog to change any information located 
here.

Computer Language Information
For storing data that affects how Editron handles language specific template information, recognizing 



words and comments. The name and value pairs appear in are series of sections labeled [C/C++], [ASM],
[PASCAL], etc. Use the Language Setup dialog    to change any information located here.

File Name Extension Information
For storing data that affects how Editron associates file name extension specific to certain compilers, 
linkers, indentation, tab stops, recognizing words and comments.    The name and value pairs appear in 
are series of sections labeled [Ext_C], [Ext_CPP], [Ext_ASM], [Ext_PAS], etc. Use the Tabs Setup dialog
to change any information located here.



File
Files are documents stored permanently on disk.    To work with existing files, you must read them into 
memory buffers.    Saving a buffer for the first time or under a new name creates a new file.



Language Template File Format
Templates automate the job of creating source code.    Each template contains the syntax of a particular 
language.    Using Editrons templates, you can complete language expressions, tailor indentation, and 
match pairs of characters.    Editrons templates are tailored for your programming language.    Template 
files have.TML extensions.    You shouldnt need to edit these files, although you can if necessary. See 
also the Language dialog.

Completing expressions
Type enough characters for Editron to recognize a unique keyword and press the space bar.    Editron 
creates the skeleton structure for you to fill in.    If you are working in C for example, typing fo produces a 
skeleton for loop.

In the template file, completing expressions rules appear in the section labeled [templates].    A line in this 
section has this format:

keyword = <body of template>

The following format symbols determine how the expression appears on the screen:

& The cursor position in the expression after the template is inserted.
Or the end of the abbreviated keyword.

\n An end of line character.
@ A backspace.
\t A tab space.

In the example: fo&r = for (&;;)\n{\n}, the first & indicates that only fo needs to be typed before the 
template line is matched.    The second & indicates that the cursor's final position is inside the 
parentheses before the first semicolon. The \n symbols place each bracket on a new line.

Matching indentation
For corresponding pairs of symbols, Editron matches indentation.    For example, Editron automatically 
matches the indentation of begin and end statements.

In the template file, indentation rules appear in the section labeled [operational_pairs].    A line in this 
section can have one of these formats:

symbol1 \tsymbol2
symbol2 \bsymbol1
symbol1 \tsymbol2 | \tsymbol3 | \tsymbol4 | ...
symbolN \bsymbol1 | \bsymbol2 | \bsymbol3 | ...

The following symbols determine how Editron searches for matching indentation symbols:

\t                      Look for match toward the top of the buffer.
\b                    Look for match toward the bottom of the buffer.
|                        Multiple possible matches.

Examples:

begin \tend
end \bbegin | \bcase | \brecord

Matching pairs
Editron can recognize parentheses, brackets, and comment symbols and find the ones that match.    This 
is useful when you are tracking down syntax errors.    You access this feature using the Match Pairs 



command.

Define matching pairs of characters in the section of the template labeled [matching_pairs].    Use one of 
the following formats:

symbol1          \tsymbol2
symbol2          \bsymbol1
symbol1          \tsymbol2 | \tsymbol3 | \tsymbol4 | ...
symbolN        \bsymbol1 | \bsymbol2 | \bsymbol3 | ...

The following symbols determine how Editron searches for matching symbols:

\t                      Look for match toward the top of the buffer.
\b                    Look for match toward the bottom of the buffer.

Examples:

begin          \tend
end              \bbegin | \bcase | \brecord
(*                    \t*)
*)                    \b(*



Macro Command File Format
A macro command file is a series of keystrokes, mouse actions, or menu choices that you record and play
back.    You record the sequence using the Record command and play it back with the Playback 
command.    If you like, you can edit the file containing a macro.    By default, macro files have the 
extension KSM.    Access the Record and Playback commands from the Tools menu, the tool bar, or the 
status boxes.

All macro scripts begin with MACRO <Title>, where <Title> is optional, and end with ENDM.    A macro 
command has one of these formats:

[repeat factor] command
[repeat factor] command parameter1
[repeat factor] command parameter1 paramater2
[repeat factor] 'character'

The [repeat factor] is an optional positive number, indicating how many times this command must be 
repeated.

Command is any Editron command.    

Parameter1 and parameter2 are integers or a regular expression string patterns required by some 
commands.    Only replace commands require two parameters. 

Character is a simple text string.    This type of macro inserts the text at the current cursor location. 

Example:

MACRO Join to the next line
beginning_of_line 
search_fwd ".$"
delete_next_char 
ENDM



MDI
The IBM Multiple Document Interface standard.    Editron is based on these guidelines.    Each edit 
window is considered a document.



Mouse Usage
Use the left mouse button for most operations like selecting menu items, clicking buttons, and selecting 
text.    You can also use the mouse to quickly specify a new buffer by clicking and dragging over an 
empty portion of the Editron window area.    Clicking on the status bar will invoke common operations and
dialogs.

Use the right mouse button for box block selections and setting the right margin on the tab ruler.



Regular Expression
A regular expression is a pattern of text used in search and replace operatons.    Use regular expressions 
in the Text To Find field of the Search dialog box to locate words that vary in spelling.    They also can 
locate text at the beginning or end of a line, special characters, or other unique patterns.

Editron recognizes the following symbols in a regular expression:

^ Matches the beginning of a line.
$ Matches the end of a line.
. Matches any character.
* Matches zero or occurrences of the previous expression.
+ Matches one or more occurrences of the previous expression.
[ ] Matches any enclosed character, but no others.    The order of the characters is not important.    If 

the first character is a caret (^), the expression matches any character except the characters in 
the string.

\ Interprets the following character either literally, \$ is a dollar sign character, or specially, \n means
an end-of-line mark.

- Indicates a range of characters to use in the pattern match

Any character not listed matches that character only.

Note: Four of these characters (&, ., *, and +) do not have any special meaning in a bracketed set.    
Also, Editron only recognizes a carat (^) if it immediately follows the left bracket ([).

Examples:

[aeiou0-9] Match vowels and 0 through 9.
[^aeiou0-9] Match anything but the vowels and 9 through 9.
to* Matches "t", "to", "too", "tooo", "toooo", etc.
to+ Matches "to", "too", "tooo", "toooo", etc.
^#include Matches "#include" starting at the first column of a line.
f.n Matches "fun", "fan", "fen", "fin", "fpn", etc.
end$ Matches "end" with at the end of a line.
\$ Matches a dollar sign.
\\ Matches a backslash.
\n Matches an end-of-line mark.
\t Matches a horizontal tab mark.



Status Boxes
The Editron status boxes gives you current information regarding the current window and global settings.  
Certain operations are available by clicking on a status box.    If you hover the mouse pointer over a status
box then an information message will appear to suggest an available operation.

For information, click one of the status boxes below.



Tab Ruler
The tab ruler gives you a guide for adjusting tab stops and the right margin.    Display or hide the ruler bar 
at the top of each edit window by selecting the Show (or Hide) Tab Ruler item from the Tools menu, or by
clicking the Show Tab Ruler button on the Tool Bar.

The tab ruler only affects the current edit window when the Use Tab Line box is checked.    See Tabs 
Setup dialog.

For information on adjusting tab stops and the right margin, click one of the items on the tab ruler.



Tab Stop
To set a new tab stop, click on the tab ruler at the point of the new tab.    A new tab marker appears. 

To delete a tab stop, click and drag the tab marker off the tab ruler.    The tab stop disappears.



Right Margin
Using the right mouse button, click on the tab ruler where you want the new margin.    The right margin 
moves to the new position.



Every Tenth Column
Each tick mark on the tab ruler is called a column.    Editron numbers every tenth column.    For example: 
The 10th column is 1 and the 30th column is 3.



Tools
Tools provide a number of services for editing, software development, and general housekeeping.    
Editron gives you access to its own tools and other software utilities.

Editron tools
Change Directory Dialog 
Clicking On The Status Boxes 
Compiler Error Parsing 
Directory Tree Dialog 
Drag and Drop 
Drawing A New Edit Buffer Window 
Find Dialog 
File Delete Dialog 
Keystroke Macro Management 
Match Pair Command 
Mouse Controlled Selection of Blocks 
Tab Ruler Command 
Tool Bar Buttons 

Non-Editron tools
Calculator 
Character Map Display 
Compiler 
Debugger 
Linker 
Invoke the DOS Window 
Make Utility 
Run Any Program 



Window
A window provides a view into a buffer. 

A window has one, and only one, buffer.    However, a single buffer can have multiple windows.    This 
technique lets view two or more parts of a buffer at the same time.    For example, you can cut and paste 
text between the first page and last page of a document.    

The title bar of each window shows the name of the buffer's file.    If 
a buffer has multiple windows, the file name on each title bar is followed by a unique sequence number.    

There is a buffer cursor for each window.    You can move this cursor using keyboard commands or the 
mouse.



Undo And Redo

Undo reverses a prior Editron command.    

Redo reverses an Undo command.    

As you issue Editron commands, they go onto a stack.    The Undo function pops the last command off 
the stack, reversing its effects.    The effect of Undo is not permanant.    The Redo function can push a 
command back onto the stack, recreating its effect.    To adjust the stack size see the Max. Macro 
Recording filed in the Advanced Setup dialog.

Undo and Redo are available on the tool Bar, the Edit Menu and via a Keystroke.

Group Undo

When the Group Undo option is on, Undo reverses the effects of the previous command and all 
immediately preceding commands of the same type.    It can reverse a sequence of insertions, deletions, 
overstrikes, and cursor movements.    This process does not work across line boundaries.

When the Group Undo feature is off, Undo reverses the effect of a single Editron command or keystroke.

Example

If Group Undo is on and you type EDITRON, the Undo command deletes the entire word.

If you select Redo after the previous example, the entire word EDITRON appears.

If Group Undo is off and you type EDITRON, the Undo command deletes the last letter.    To delete the 
whole word, you need to use Undo seven times. 

If you select Redo after the previous example, a single letter appears.

See also the Setup dialog.



Using Editron Help
The Editron help system has three levels:    

The topmost level is the Contents page.    

The next level contains major topics: Commands, Compiling And Linking, Dialogs, Editron Concepts,
Glossary, Keyboard, Macros, Menus, Mouse Usage, Tool Bar, and Using Editron Help.    

The final level has pages of detailed information.    Many of these pages are cross linked.    

The Editron help menu has several features for easy navigation.    Choose the alternate Contents 
window for quick access to all the second level topics.    The Glossary and the Contents page have their
own buttons on the Help tool bar.    

Choose the Editron Concepts page for a "how-to" overview of Editron.



Editron Concepts

In Editron, every document (source code or other text) can have three components:    disk files, memory 
buffers and edit windows.    

Each disk file contains one document.    To edit this document, you need to open its file and copy the text 
into a memory buffer.    There is a one-to-one relationship between files and buffers.

A window shows the contents of a buffer.    A buffer can have more than one window, each offering a 
unique view.

The illustration below shows the main features of Editron.    Click any part it for information on the 
corresponding feature.



System Menu
Use this control to get standard MS Windows program system menu.



Title Bar
This line shows the name of the Editron application program.    Double click here to either maximize or 
normalize Editron.



Current Directory
This is the current directory that Editron uses for operations that require it.



Minimize Button
Click here to minimize Editron into an icon.



Maximize Button
Click here to expand Editron so it takes up the entire screen.



Edit Window Icon
This is an iconized edit window.    Double click on it to view it's contents and to perform text editing.



Edit Window Icon Title
This is the file associated with the iconized edit window, unless it is a newly created buffer which has not 
yet been assigned to a file.



Main Menu: File
Files Submenu 



Main Menu: Edit
Edit Submenu 



Main Menu: Blocks
Blocks Submenu 



Main Menu: Search
Search Submenu 



Main Menu: Go To
Go To Submenu 



Main Menu: Macro
Macro Submenu 



Main Menu: Tools
Tools Submenu 



Main Menu: Options
Options Submenu 



Main Menu: Window
Window Submenu 



Main Menu: Help
Help Submenu 



Tool Bar
This bar contains buttons that perform 23 of the most common operations in Editron.



Tool Bar: Current Keystroke Mapping
This is the name of the current keystroke mapping.



Edit Window: Title Bar
This line shows the name of the file associated with the buffer that underlies a window.    For a new buffer 
that is not tied to a disk file, the title bar says <Untitled>.    Otherwise, the title bar shows the name of the 
buffers disk file.    If you have multiple windows for a single buffer, the title on each window contains a 
sequence number.    You can double click this line to maximize the window.



Edit Window: Minimize Button
Click here to minimize the edit window into an icon within Editron. 



Edit Window: Maximize Button
Click here to expand the edit window so it takes up all of Editron.



Edit Window: Text
This area displays your text.



Edit Window: Selected Text
The user has selected this area of text for further processing such as copying or deletion.



Edit Window: Vertical Scroll Bar
This tool moves the text in a window up and down. 



Edit Window: Horizontal Scroll Bar
This tool moves the text in a window right and left.



Edit Window: System Menu
Click here to get the system menu for the edit window.



Edit Window: Tab Ruler
This displays the tab stops and right margin associated with this window.    



Edit Window: Line Numbers
This displays the line numbers for the buffer.



Edit Window Buffer Cursor Position
This box shows the position of the cursor in the active window cursor position.    The first number is the 
current line and the second number is the current column.    Double click here to invoke the Go To Line 
dialog.



Edit Window Modified Text Status
This box tells whether or not the text in the current window has been modified.    

The box also allows the current buffer of the active window to be saved.    Click it to save the buffer.    If 
the buffer is not associated with a file then the Save Buffer As dialog will appear.



Edit Window Edit Mode
This box shows the edit mode of the current window.    The possibilities are:

Insert: When you type a character, Editron inserts it at the point of the cursor, preserving existing text.

Overwrite: When you type a character, Editron deletes the character to the right of the cursor and 
replaces it with the new character.

The box also controls the insert or overwrite editing mode.    Click it to switch between modes.



Edit Window Recording Mode
This box gives status information on keystroke macros in the current window.    When the box says RE, 
Editron is recording your keystrokes, menu selections, and mouse actions.    When the box says PL, 
Editron is playing your previously recorded keystrokes, menu selections, and mouse actions.    When the 
box says PA, Editron has paused your previously recorded keystrokes, menu selections, and mouse 
actions and is waiting for an action or series of actions before the recording will continue.

The box also controls    the recording and playback process.    Click it to begin recording a macro.    Click it
while holding down the Control key to play the current macro.



Edit Window Information
Editron displays many kinds of messages in this box.    Some provide general information about a menu 
option, button, or other screen element.    When you highlight a block of text, Editron displays its 
dimensions in this box.    Error messages go here, too.



Compiler Results: Title Bar
This displays the title "Compiler Results".



Compiler Results: System Menu Button
Click here to get the system menu for the compiler results window.



Compiler Results: Minimize Button
Click here to minimize the compiler results window into an icon within Editron. 



Compiler Results: Maximize Button
Click here to expand the compiler results window so it takes up all of Editron.



Compiler Results: Text
This area displays the error results from the most recent compilation.    Double click on a line to bring up 
the edit window and line on which the compiler error occured.    See also the Tool Bar, the Go To menu 
or the Keyboard commands. 



Compiler Results: Vertical Scroll Bar
This tool moves the text in a window up and down. 



Compiler Results: Horizontal Scroll Bar
This tool moves the text in a window right and left.



Go To Bookmark: System Menu Button
Double click here to dismiss the dialog.



Go To Bookmark: Title Bar
This Go To Bookmark dialog facilitates jumping around the text.



Tool Bar
This provides buttons for many of the most common Editron commands.    To adjust the tool bar, such as 
changing the size of the buttons, see the Tool Bar Style toggles of the Setup dialog.
 
For information, click one of the buttons on the tool bar.



Search or Replace Forward
If the down arrow is blue then this invokes the Search Forward command, otherwise if the down arrow is
red then this invokes the Replace Forward command. 



Search or Replace Backward
If the up arrow is blue then this invokes the Search Backward command, otherwise if the up arrow is red
then this invokes the Replace Backward command. 



Keyboard
This index lists the keystrokes in Editron's default keymap.    Click on one of the keystrokes below to see 
the corresponding Editron command.    Other keymaps produce different commands.    See also the 
Keymap Setup dialog.

The entries in this index use these symbols:

alt:    Hold down the Alt (or alternate) key while pressing the next keystroke.
ctrl:    Hold down the Ctrl (or control) key while pressing the next keystroke. 
shift: Hold down the Shift key while pressing the next keystroke.

A symbol in angle brackets indicates a literal keystroke.    For example, the End key is <END>.

alt-B 
alt-C 
alt-E 
alt-F 
alt-G 
alt-H 
alt-M 
alt-O 
alt-P 
alt-S 
alt-T 
alt-V 
alt-W 
alt-X 
alt-Z 
alt-0 
alt-1 
alt-2 
alt-3 
alt-4 
alt-5 
alt-6 
alt-7 
alt-8 
alt-9 
alt-<BSP> 
alt-<DEL> 
alt-<INS> 
alt-<F4> 
alt-<F5> 
alt-<F6> 
alt-<F7> 
alt-<F8> 
alt-<F9> 
alt-<F10> 
alt-shift-R 
ctrl-A 
ctrl-B 
ctrl-C    
ctrl-D 
ctrl-F 
ctrl-J 



ctrl-L 
ctrl-M 
ctrl-N 
ctrl-O 
ctrl-P 
ctrl-R 
ctrl-S 
ctrl-T 
ctrl-U    
ctrl-V    
ctrl-W 
ctrl-X    
ctrl-Y 
ctrl-Z 
ctrl-0    
ctrl-1 
ctrl-2 
ctrl-3 
ctrl-4 
ctrl-5 
ctrl-6 
ctrl-7 
ctrl-8 
ctrl-9 
ctrl-<BREAK> 
ctrl-<BSP> 
ctrl-<CANCEL> 
ctrl-<DEL> 
ctrl-<DOWN> 
ctrl-<END> 
ctrl-<ENTER> 
ctrl-<F1> 
ctrl-<F2> 
ctrl-<F3> 
ctrl-<F4> 
ctrl-<F5> 
ctrl-<F6> 
ctrl-<F7> 
ctrl-<F8> 
ctrl-<F9> 
ctrl-<F10> 
ctrl-<F11> 
ctrl-<INS> 
ctrl-<HOME> 
ctrl-<LEFT> 
ctrl-<RIGHT> 
ctrl-<UP> 
ctrl-shift-D 
ctrl-shift-M 
ctrl-shift-R 
ctrl-shift-S 
ctrl-shift-U 
ctrl-shift-W 
ctrl-shift-<F1> 
ctrl-shift-<F4> 
ctrl-shift-<F6> 



ctrl-shift-<F9> 
shift-<DEL> 
shift-<END> 
shift-<HOME> 
shift-<INS> 
shift-<TAB> 
<BSP> 
<DEL> 
<DOWN> 
<END> 
<ENTER> 
<ESC> 
<F1> 
<F2> 
<F3> 
<F4> 
<F5> 
<F6> 
<F7> 
<F8> 
<F9>
<F10> 
<F11> 
<HOME> 
<INS> 
<LEFT> 
<PGDN> 
<PGUP> 
<RIGHT> 
<TAB> 
<UP> 



Close Edit Window
(ctrl-<F4>): Closes the current edit window.



Go To Next Edit Window
(ctrl-<F6>): Moves the cursor to the next window.    See also the next_window command. 



Join Two Lines
(ctrl-J): This appends the next line to the current line.    This keystroke invokes a keystroke macro, 
JOINLINE.KSM.    See also the Macro menu, the Macro/Key Binding dialog and the Macro command 
syntax. 



Macro Commands
A macro file is a sequence of macro commands.    You can create a macro by turning on Editrons 
recording feature.    As you work, Editron saves your keystrokes, mouse actions, and menu selections.    
You can store these commands in a macro file and play them back later.

Editrons macro commands fall into several categories:

Cursor Movement within a Buffer

beginning_of_line 
down 
end_of_buffer 
end_of_line 
end_of_window 
go_mark_0 
go_mark_1 
go_mark_2 
go_mark_3 
go_mark_4 
go_mark_5 
go_mark_6 
go_mark_7 
go_mark_8 
go_mark_9 
goto_column N 
goto_line N 
left 
left_side 
line_to_bottom 
line_to_top 
ndown N 
next_word 
nleft N 
nright N 
nup N 
page_down 
page_up 
previous_word 
right 
right_side 
scroll_down 
scroll_left 
scroll_right 
scroll_up 
top_of_buffer 
top_of_window 
up 

Block Selection and Operations

close_block 
copy_block
copy_to_clip 
copy_to_clip_scrap 



copy_to_scrap 
cut_to_clip 
cut_to_clip scrap 
cut_to_scrap 
delete_block 
indent_block 
move_block 
outdent_block 
paste_from_clip 
paste_from_clip_scrap 
paste_from_scrap 
reformat_all 
reformat_block 
select_box 
select_line 
select_stream 
to_lowercase 
to_uppercase 
unselect_block 

Character, Word and Line Operations

backspace 
center_line_in_N_cols
center_line_in_win 
'<character>' 
delete_line 
delete_next_char 
delete_next_word 
delete_previous_char 
delete_previous_word 
delete_to_EOL 
insert_filename 
insert_new_line 
last_srch_repl_back 
last_srch_repl_fwd 
match 
open_line 
replace_again 
replace_back "<string pattern 1>" "<string pattern 2>" 
replace_fwd "<string pattern1>" "<string pattern 2>" 
search_again 
search_back "<string pattern>" 
search_fwd "<string pattern>" 
tab_insert 

Miscellaneous

case_toggle 
insert_mode 
numbers_toggle 
pause_recording 
print_block 
print_buffer 



print_buffer_block 
reg_expr_toggle 
repeat
save_buffer 
tab_ruler 
write_block 



Go To Column N
goto_column N: This command moves the cursor to the Nth column on the same line.



Go To Line N
goto_line N: This command moves the cursor to the Nth line in the same column.



Down N Lines
ndown N: This command the cursor down N lines from the present line.    The column remains the same.



Left N Columns
nleft N: This command moves the cursor left N columns from the present position.



Right N Columns
nright N: This command moves the cursor right N columns from the present position.



Up N Lines
nup N: This command moves the cursor up N lines from the present line.    The column remains the same.



Insert Character
'<character>': This command inserts a literal character.



Replace Backwards
replace_back "<string pattern 1>" "<string pattern 2>": This command replaces the first string pattern with 
the second string pattern.    The first string can use regular expression notation.    Editron searchs 
backward toward the beginning of the buffer from the current position of the cursor.



Replace Forwards
replace_fwd "<string pattern 1>" "<string pattern 2>": This command replaces the first string pattern with 
the second string pattern.    The first string can use regular expression notation.    Editron searchs 
forward toward the end of the buffer from the current position of the cursor.



Search Backwards
search_back "<string pattern>": This command searchs for the string pattern and stops on the first match. 
The string can use regular expression notation.    Editron searchs backward toward the beginning of the 
buffer from the current position of the cursor.



Search Forwards
search_fwd "<string pattern>": This command searchs for the string pattern and stops on the first match.   
The string can use regular expression notation.    Editron searchs backward toward the beginning of the 
buffer from the current position of the cursor. 



Dialogs
About Editron Dialog 
Advanced Setup Dialog 
Applications Dialog 
Change Directory Dialog 
Color Dialog 
Command Dialog 
Compiler Setup Dialog 
Debugger Setup Dialog 
Delete File Dialog 
Directory Tree Dialog 
Drop Bookmark Dialog 
Edit Keymap Dialog 
Execute Macro Dialog 
File Open Dialog 
Fill Block Dialog 
Find Dialog 
Font Dialog 
Go To Bookmark Dialog 
Go To Line Dialog 
Interwindow Block Copy Dialog    
Interwindow Block Move Dialog    
Keymap Dialog 
Language Dialog 
Linker Dialog 
Load File for Debugger 
Load Key Map Dialog 
Load Macro Dialog 
Macro/Key Binding Dialog 
Make Utility Setup Dialog 
Printer Setup Dialog 
Repeat Dialog 
Replace Dialog 
Run Dialog 
Save Block As Dialog 
Save Buffer As Dialog 
Save Keymap As Dialog 
Save Macro Dialog 
Search Dialog 
Setup Dialog 
Tabs Dialog 
Unassigned Keys Dialog 
Windows Selection Dialog 



About Editron Dialog
Shows the start up screen containing copyright and version information.    A mouse click or any keystroke 
closes this dialog box.    For more information, click the OK button on the dialog box.



Advanced Setup Dialog
Configures many of Editrons advanced global options.    For more information, click on one of the controls 
in the dialog box.    This dialog invoked by the Advanced button in the Setup dialog.



Styles of Saving: Save/Restore Layout Toggle
Check here if you want Editron to remember the screen layout and editing conditions between sessions.    
If the box is checked, Editron saves the status of its windows and buffers when you exit the program.    It 
restores them the next time you start the program.



Styles of Saving: Save As...Changing File Names Toggle
This control determines the title of a buffer after you save its contents using the Save Buffer As dialog 
box.    Check here to change the title to the new file name.    Clear the box to use the existing name.



Styles of Saving: No Backups Radio Button
Click here to prevent Editron from creating automatic backup files.



Styles of Saving: Create .BAK File Radio Button
Click here if you want Editron to make automatic backup files.    These files have the extension BAK.



Styles of Saving: Copy to Backup Directory Radio Button And Field
Click here if you want Editron to place backup files in a specific directory.    Enter the name of the directory
in the field.



Styles of Saving: DOS Radio Button
Click here if you want Editron to create text files using the DOS end-of-line convention.    All lines end with 
the carriage return and line feed characters.



Styles of Saving: UNIX Radio Button
Click here if you want Editron to create text files using the UNIX end-of-line convention.    All lines end with
the line feed character.



Write Periodically
If you want Editron to periodically save all buffers in their respective disk files, enter a number in this field. 
The value is the number of minutes between save operations.



Maximum Undo Depth
In this field, enter the number of commands that the Undo function can recall. 



Maximum Macro Recording
In this field, enter the number of commands that the Macro function can record.



Numbers Field Width
Enter the width of the column that holds line numbers in this field. 



Virtual Lines
Enter the number of surrogate or virtual lines that appear after the last physical line of text in a buffer.    
You can move the cursor into these virtual lines, even though theres no text at that point.    The advantage
they give is the ability to continue scrolling text past the end of a document.



Cursor Shapes: Insert In Existing Text
Click here and choose a cursor shape from the pull-down list.    This shape appears in insert mode when 
the cursor is within text.



Cursor Shapes: Insert In Non-Text Area
Click here and choose a cursor shape from the pull-down list.    This shape appears in insert mode when 
the cursor is outside a text area.



Cursor Shapes: Overwrite In Existing Text
Click here and choose a cursor shape from the pull-down list.    This shape appears in overwrite mode 
when the cursor is within text.



Cursor Shapes: Overwrite In Non-Text Area
Click here and choose a cursor shape from the pull-down list.    This shape appears in overwrite mode 
when the cursor is outside a text area.



OK
Click here to close the dialog box and use its settings in the current Editron session and future sessions.



Cancel
Click here to close this dialog box and use the existing configuration for Editrons global settings.



Help
Click here for help information on this dialog box.



OK
Click here to close this dialog box.



Applications Dialog
Specifies the programs that Editron runs when you choose the DOS, Char Map, Calculator, and SDK 
Help options. For more information on these programs, click the appropriate field in the dialog box.



DOS Prompt
The MS Windows PIF file that starts a DOS session. Editron runs this PIF file when you choose the DOS 
option on the File menu. 



Full Screen Toggle
Check this box to run DOS in a full screen display.    Otherwise, the DOS session occurs in a window.



Calculator
The name of the calculator program. Editron runs this program when you select the Calculator option on 
the Tools menu.



Character Map
The name of the character map utility. Editron runs this program when you select the Char Map option on 
the Tools menu.



Software Development Kit Help
The name of the program that provides online help for your software development kit (SDK). Editron runs 
this program when you select the SDK Help option on the Editron Help menu.



List of Known SDK Help Files
Click here to display a list of known software development kit (SDK) help files.



Delete
Click here to delete the active SDK help file.



Add New
Click here to add a new help file to the know list of SDK help files.    This invokes the File Open dialog.



OK
Click here to record your settings and close the dialog box.



Cancel
Click here to close the dialog box without changing any of its settings.



Help
Click here to see help text for this dialog box.



Change Directory Dialog
Sets the default directory for reading and writing disk files. For more information, click one of the fields or 
other controls on the dialog box.



Directories
Displays the directory tree structure from the point of view of the current directory.    You see all the 
directories above and below the current one.    Click on a directory name to move into it. Double-click to 
move into a directory and exit the dialog box.



Directory
Displays the full path name of the current directory.



Drive
Displays a scrollable list of drive letters.



OK
Click here to change the default directory to the one in the field of the top of the dialog box. You return to 
the editing window.



Cancel
Click here to exit the dialog box without changing the default directory.



Help
Click here to see help text on this dialog box.



Color Dialog
Sets the color for text, compiler error messages, and eight other screen elements.    Examples of each 
element appear in the box beneath the color palettes. To change the color of an item, enter its name in 
the Screen Element field.    Then choose a foreground and background color using the two palettes. For 
information on these controls, click one of the fields or other items on the dialog box.



Screen Element
This field shows one of the screen elements with adjustable color.    Enter the name of an element or click 
on its example in the box beneath the palettes.    Use the color buttons on the foreground and background
palettes to change the colors of the item in this field.    You can select any combination of colors for any 
item except selected text.    This text must have complementary foreground and background colors.



Screen Element List
Click this button for a pull-down list of all ten elements with adjustable color.



Color Palettes: Foreground
These 16 colors are your choices for the foreground of the selected screen element.    The current color 
contains a dot.    Click another color to change the foreground.



Color Palettes: Background
These 16 colors are your choices for the background of the selected screen element.    The current color 
contains a dot.    Click another color to change the background.



Sample Texts
This box shows the ten screen elements with their current colors. Click one of these examples to place its
name in the Screen Element field.



OK
Click here to close this dialog box and make its color selections permanant..



Cancel
Click here to close this dialog box and return to the previous color selections.



Default
Click here to use the standard colors.



Help
Click here to see help information for this dialog box.



Command Dialog
Executes one of Editrons built-in commands.    Many of these commands are not available from the 
menus or other controls.    You can run one of these commands manually using this dialog box. For more 
information, click one of the fields or other controls on the dialog box.



Command
Enter the name of an Editron command in this field.    Type the name or choose one from the pull-down 
list.    As you type, Editron attempts to match each letter with one of the existing commands.



Command List
Click this button for a list of Editron commands.



OK
Click here to run the selected Editron command.



Cancel
Click here to close the dialog box without running a command.



Help
Click here for help information about this dialog box.



Compiler Setup Dialog
Configures Editron for a programming language compiler.    Use the controls on this dialog box to describe
your compiler and associate it with a file name extension.    Editron stores this information in a template 
file for each language.    When you compile a source file, Editron looks at the extension of its file name to 
determine the appropriate compiler.    For example, if a file ends with the extension .C, Editron runs the 
compiler you associated with that extension.    For more information on one of the compiler setup controls,
click a field or other item on the dialog box.



Filename Extension
Enter an extension in this field.    Editron uses this extension to match a file of source code with a 
particular programming language and compile.



Filename Extensions List
Click here to see a list of suggested extensions for some popular languages.



Compiler
Enter the name of your compiler in this field.    Type the name of the software product, not a DOS file 
name.



Compiler List Button
Click here for a list of known compilers.    When you select a compiler in this list, the appropriate 
information appears in the other fields.



Path Name
Enter the DOS path and executable file name of the compiler.



Command Line
If your compiler requires command line arguments, enter them in this field.



Command File
If you store compiler options in a disk file, enter the files name in this field.    This technique is useful if a 
compiler cannot accept a long command line.



Errors Log File
If you want Editron to store compiler errors in a disk file, enter the files name in this field.



Errors Format
Enter a string of characters that represents the compiler error format in this field.    Editron uses this 
format information to understand the error messages from your compiler.    Click the adjacent button for a 
list of common error formats.    For an explanation of the formatting codes, see the Editron manual.



Errors Format List Button
Click here for a list of compiler error formats.    Each character string in the list represents the syntax of 
a compiler error message.    The error format for your compiler is probably in this list.    For an explanation 
of the formatting codes, see the Editron manual.



Compile Background Toggle
Check this box if you want to run your compiler as a background task under MS Windows.



Save Compile Buffer Toggle
Check here if you want Editron to save your source code file before compiling it.    If this box is clear, 
Editron saves your source code in a temporary file, compiles it, and then deletes the temporary file.



Full Size DOS Window Toggle
Check here to run your compiler in a full screen DOS session.    This option is recommended for 
maximum compilation speed.



Errors Parsing Toggle
Check here if you want Editron to examine the output of your compiler for error messages.    Use this 
option for assistance in locating errors in your source code.



OK
Click here to save these settings in a template file for the selected compiler.    The next time you run this 
compiler, Editron uses these settings. 



Cancel
Click here to close the dialog box without changing any compiler settings.



Delete
Click here to delete the current compiler template from the disk. 



Help
Click here to see help information about this dialog box.



Debugger Setup Dialog
Configures Editron for use with your debugger program.    For more information, click one of the fields or 
other controls on the dialog box.



Debugger
Enter the full name of the debugger in this field.



Debugger List
Click this button to see a list of debugger programs.



Path Name
Enter the DOS path and executable file name of the debugger in this field.



Command Line
If your debugger requires command line arguments, enter them in this field.



Non-Windows Debugger Toggle
Check here to use a character-mode DOS debugger.    You can run a this debugger in a window or on the 
full screen.



Full Size DOS Window Toggle
Check here to run your character-mode debugger in a full screen DOS session.    This option is 
recommended for maximum execution speeds.    This item is only available if you check the Non-Windows
Debugger option.



OK
Click here to use the settings on this dialog box in future debugging sessions. You return to the Editron 
editing screen. 



Cancel
Click here to close this dialog box and use the existing debugger settings.



Delete
Click here to remove the current debugger template from the disk. 



Help
Click here to see help information about this dialog box.



Delete File Dialog
Deletes a file.    This dialog box provides a handy way of removing object files when you want to recompile
a program with your make utility.    For more information, click one of the fields or other controls on the 
dialog box.



File Name
Enter the name of the file you want to delete.    Enter a name with wild-card characters to see the 
matching names in the list of files. 



File Name History
Click here to see a list of deleted files. 



File Name Clear History
Click here to remove all the names from the list of deleted files.



File Name Extension
Enter a file name extension, preceded by a period and asterisk, in this field.    Alternatively, choose one of 
the common extensions from the pull-down list.    Editron displays the matching files.



File Name Extension List
Click here to see a list of file name extensions.



File Name Extension Clear List
Click here to clear all the entries from the list of file name extensions.



Files
This list shows the files that match the specification in the file name field.    Click a file name to select it.



Directory
This box shows the full path name of the current directory.



Directories
This box shows the directory tree structure.    It shows all the directories above and below the current one.
Click on a directory name to use it as the default.



Drive
Choose one of the letters in this list to move to the corresponding disk drive.



OK
Click here to delete the selected file and close this dialog box.



Cancel
Click here to close the dialog box without deleting a



Help
Click here to see help information for this dialog box.



Directory Tree Dialog
Shows the directory hierarchy for the current disk.    For more information, click one of the fields or other 
controls on the dialog box.



Directory Tree
This box shows the entire directory structure.    The current directory is highlighted.



Drives
This box shows a list of drive letters.    The current disk appears highlighted.    Click on a letter to move to 
the corresponding disk. The current drive is highlighted. 



Directory
This box shows the full path name of the current directory.



Scan
Click here to scan the directory tables of the current disk and reconstruct the directory tree.    Editron 
automatically scans the disk the first time this dialog box appears.



OK
Click here to close the dialog box.



Cancel
Click here to stop scanning the disk.    This option is handy if it takes too long to scan a drive.



Help
Click here for help information on this dialog box.



Drop Bookmark Dialog
Inserts one of ten numbered markers at the cursor position.    Use the Go To Bookmark command to 
return to one of these locations.    For more information, click one of the buttons on the dialog box.



Button
Click a button to place a bookmark with the corresponding number in the current buffer at the cursor 
position.    



Used Button
The underline indicates that the bookmark for this button has already been assigned.    Click the button to 
move the bookmark from its old position to the location of the cursor.



Edit Keystroke Dialog
Associates keystrokes with Editron commands.    You can define a primary and secondary keystroke for 
each command.    You can also group related keystrokes in a keymap.    Editron comes with several 
predefined keymaps.    To learn about the features of this dialog box, click a field or other item.    See also 
the Keystrokes and Commands.



Command
Enter the name of an Editron command in this field.    You can type the name of the command or choose 
one from the pull-down list.    As you type, Editron examines the letters and tries to match them with an 
existing command.



Command List
Click here to see a list of Editron commands.    Click on a command to place its name in the Command 
field.



Key 1: Field
This field shows the primary keystroke for the current command.    This is the keystroke sequence you 
record with the Key Define dialog box.



Key 1: Insert Button
Click here to define a primary keystroke for the current command.    You see the Key Define dialog box.



Key 1: Delete Button
Click here to erase the contents of the primary keystroke field.



Key 1: Find Available Keystroke Button
Click here for a list of available keystrokes.    You see the Unassigned Keys dialog box.    Select a 
keystroke using this dialog box and click OK to enter the keystroke in the primary key field.



Key 2: Field
This field shows the secondary keystroke for the current command.    This is the keystroke sequence you 
record with the Key Define dialog box.



Key 2: Insert Button
Click here to define a secondary keystroke for the current command.    You see the Key Define dialog 
box.



Key 2: Delete Button
Click here to erase the contents of the secondary keystroke field.



Key 2: Find Available Keystroke Button
Click here for a list of available keystrokes.    You see the Unassigned Keys dialog box.    Select a 
keystroke using this dialog box and click OK to enter the keystroke in the secondary key field.



OK
Click here update the current keymap with the settings on this dialog box.    You return to the Editron 
editing screen.



Cancel
Click here to close the dialog box without changing the current keymap.



Help
Click here to see help information about this dialog box.



Allow Number Lock Toggle
Click here if you want to allow the number lock function for all keystrokes in every keymap.



Allow Capital Shift Lock Toggle
Click here if you want to allow the caps lock function for all keystrokes in every keymap.



Execute Macro Dialog
Loads a keystroke macro from a disk file and executes it.    For more information, click one of the fields or 
other controls on the dialog box.



Macro File
Enter the DOS file name for the keystroke macro in this field.    



Macro Name
Enter the English description of the keystroke macro in this field. 



Macro Names List
This list shows the macros on the disk.    The DOS file name appears first, followed by a colon and the 
English description.



OK
Click here to load and execute the selected macro.



Cancel
Click here to close the dialog box without loading or running a macro.



Delete
Click here to delete the selected macro from the disk.



Help
Click here to see help information about this dialog box.



File Open Dialog
Opens a disk file, loads its contents into a new buffer, and creates a window to display its text.    For more 
information, click one of the fields or other controls on the dialog box.



File Name
Enter a file name or a pattern with wildcards in this field.    A complete name specifies a single file to open. 
A pattern with wildcards displays a list of matching files.

Examples of wild card names:
*.h
*.c
*.pas
*.*
*.
test*.c
*.h;*.c;*.cpp    (note semicolons)



File Name History
Click here to see a list of the files youve opened during this editing session.



File Name Clear History
Click here to remove the names from the list of previously opened files.



File Name Extension
Enter a file name extension in this field, preceded by a period. The contents of this field act as a filter for 
the file name field.



File Name Extension List
Click here for a list of file extensions.



File Name Extension Clear List
Click here to remove the entries from the list of file extensions.



List of Files
This box shows files in the current directory.    This list shows the files that match the specifications in the 
file name and extension fields.    Click on a name to select the file.



Directories
This box displays the directory tree structure.    It shows the directories above and beneath the current 
one.    Clicking on a directory name to make it the default.



Directory
This field contains the full path name of the current directory.



Drive
This box shows a scrollable list of drive letters.    Click one to move to the corresponding disk drive.



OK
Click here to open the selected file and edit its contents.



Cancel
Click here to close the dialog box without loading a file.



Help
Click here to see help information on this dialog box.



Fill Block Dialog
Fills a highlighted block with a text pattern.    Click one of the controls on the dialog box for more 
information.



Fill Pattern
Enter a string of characters in this field.    When you click OK, Editron repeats this string until it fills the 
block.



Fill Pattern History
Click here to see a list of the text strings you used as fill patterns in this editing session.



OK
Click here to close the dialog box and fill the block with the current text pattern.



Cancel
Click here to close the dialog box without using the fill pattern.



Help
Click here to see help information on this dialog box.



Find Files Dialog
Locates files by name or content.    Enter a name or specification in the File Names field.    Editron locates 
this file or group of files when you click OK.    You can narrow the search to files that contain a particular 
piece of text by entering it in the Text To Find field.    Whether or not you want to search for text, you need 
to fill in the File Names field.    Click one of the features on the dialog box for more information.



Text To Find
If you want to find files that contain a particular word or other text, enter it in this field.    You can search for
patterns of text using regular expression.    This field is optional.



Text To Find History
Click here for a list of text patterns used in previous searches.



Text To Find History Clear
Click here to delete the list of text patterns used in previous searches.



File Names
Enter a file name or specification in this required field.



File Names History
Click here to see a list of file names used in previous searches.



File Names History Clear
Click here to delete the list of file names used in previous searches.



Drive
This box shows a list of drive letters.    Click one to make it the current disk.



Entire Disk Radio Button
Click here if you want to search the entire disk.



Current Directory And Below Radio Button
Click here to limit the scope of the search to the current directory its subdirectories.



Current Directory Radio Button
Click here to limit the scope of the search to the current directory.



Case Sensitive Search Toggle
Click here if you want Editron to match the capitalization of the text in the Find Text field.



Enable Regular Expressions Toggle
Click here if you want to enter a regular expression pattern in the Find Text field..



Results Display
This window displays the files that match your search criteria.



Scan
Click here to begin searching for files that match the criteria in the File Names and Text To Find fields.



Cancel
Click here to close this dialog box without searching for files.



Help
Click here to see help information on this dialog box.



Font Dialog
Sets the font style, point size, and other characteristics of the text in the Editron display. Click one of the 
features on the dialog box for more information.



Font: Selection
This field shows the current font.    Enter a new one by typing its name or selecting it from the list.below.



Font: Selection List
This list shows the available fonts.    Click one to select it as the current font.



Font Style: Selection
This field shows the current font style, a variation on the standard font.    Enter a new one by typing its 
name or selecting it from the list.below.



Font Style: Selection List
This list shows the available font styles.    Click one to select it as the current style.



Font Size: Selection
This field shows the current size selection in points.    To make the text bigger or smaller, enter a new 
value in this field or choose one from the list below.



Font Size: Selection List
This list shows the available font sizes.    Click one to select it as the current size.



Font Display
This box shows sample text that reflects the current settings.



Printer Uses Current Screen Font Toggle
Click here if you want to use the font settings on this dialog box for printed text.



OK
Click here to close this dialog box and make its font settings permanant.



Cancel
Click here to close this dialog box without changing font settings.



Help
Click here to see help information about this dialog box.



Go To Bookmark Dialog
Moves the cursor to one of the ten numbered bookmarks.    When you click one of the ten buttons, Editron
jumps to the buffer and line where you originally dropped the corresponding bookmark.    If the buffer isnt 
the one in the foreground window, Editron moves it there.    The behavior of the bookmark palette 
depends on the status of the Close Bookmark control in the Setup dialog box.    Clear the Close 
Bookmark control if you want the button palette to remain on screen. Click one of the buttons on the 
dialog box for more information.



Button
Click one of these buttons to move to the corresponding bookmark.



Unavailable Button
A grey button, like this one, does not have an associated bookmark.    



Go To Line Dialog
Jumps to a particular line of text.    When you specify a numbered line, Editron repositions the cursor on 
that line and displays it in the editing window. In a multi-column document, Editron jumps to a new line in 
the current column.    For more information, click one of the fields or other items on the dialog box.



Number
Enter a line number in this field.



Number History
Click here to see a list of previously used line numbers.



OK
Click here to jump to the specified line. 



Cancel
Click here to close the dialog box without moving the cursor.



Help
Click here to see help information about this dialog box.



Interwindow Block Copy Dialog
Selects an edit window.    This dialog box provides a way of copying a block to another window.    For more
information, click one of the fields or other controls on the dialog box.



List of Edit Windows
This list shows the edit windows which have a selected block.    Click a window name to copy it to the 
current window.    



OK
Click here to close the dialog box and to accept the selected window.



Cancel
Click here to close the dialog box and return to the current edit window.



Help
Click here to see help information about this dialog box.



Interwindow Block Move Dialog
Selects an edit window.    This dialog box provides a way of moving a block to another window.    For more
information, click one of the fields or other controls on the dialog box.



List of Edit Windows
This list shows the edit windows which have a selected block.    Click a window name to move it to the 
current window.    



OK
Click here to close the dialog box and to accept the selected window.



Cancel
Click here to close the dialog box and return to the current edit window.



Help
Click here to see help information about this dialog box.



Key Define Dialog
Captures a keystroke for use with an Editron command or macro.
No picture available.    See also the Keystrokes and Commands.



Key Captured
When you press a key or sequence of keystrokes, its description appears in this box.



Keymap Setup Dialog
Binds Editron commands to keystrokes, assembles keystrokes into related groups called keymaps. and 
manages keymap files.    In addition to its standard set of keystrokes, Editron comes with keymaps for 
Borland C, Brief, Codewright, CUA, EMACS, MultiEdit, SlickEdit and WordStar.    You can add new 
keymaps or modify existing ones.    The current keymap remains in effect until you change it using the 
Load Keymap or Save Keymap button.    Click one of the features on the dialog box for more information.  
See also the Keystrokes, the Commands. and the Macro/Key Bindings dialog.



Current Keymap
This indicates the current keystroke-to-command mapping that is loaded.    An exclamation mark indicates
that it has been modified and not yet saved.



Command
This column shows a list of Editron commands.    Double-click a command one to edit its associated 
keystrokes.



Primary Key
This column shows the primary keystrokes assigned to the Editron commands.    Double-click one of 
these keystrokes to modify it.



Secondary Key
This column shows the secondary keystrokes assigned to the Editron commands.    Double-click one of 
these keystrokes to modify it.



Edit
Select a command in the list and click this button to edit the associated keystrokes.    You see the Edit 
Keymap dialog box. 



Add
Click here to add a new keystroke to the current keymap.    You see the Edit Keymap dialog box.



Delete
Click here to delete the items in the selected row: Editron removes the command and its primary and 
secondary keystrokes from the current keymap.



Find
Press a key and then click inside the dialog box to locate the keystroke in the current keymap.    Editron 
highlights its entry in the list of commands and keystrokes.



Print
Click here to send the current list of keystrokes and commands to the printer.



Load Keymap
Click here to open a keymap file and use its keystrokes for this editing session.    You see the Load 
Keymap dialog box.    By default, this dialog box shows files that end with the extension KB.    The last 
keymap you load or save during an Editron session becomes the default for future sessions.



Save Keymap
Click here to save the current keymap settings in a disk file.    You see the Save Keymap dialog box.    By
default, this dialog box shows files that end with the extension KB.    The last keymap you load or save 
during an Editron session becomes the default for future sessions.



OK
Click here to close the dialog box and use its current settings.    Note that this button does not 
automatically save a new or modified keymap in a disk file.    Use the Save Keymap button if you want to 
work with a new or modified keymap in future Editron sessions. 



Cancel
Click here to close the dialog box and return to the current keymap settings.



Help
Click here to see help information about this dialog box.



Language Setup Dialog
Configures Editron for use with a programming language.    You can associate a language with a template 
file and other editing features.    Templates make Editron aware of the syntax and formatting of a particular
language.    By opening a template, its easy to create clean, syntactically correct source code. . Click one 
of the features on the dialog box for more information.



Computer Language Name
Enter the name of a programming language in this field.    Type the name or choose it from the pull-down 
list.    The entry should be the proper name of the language, not an executable file name or extension.



Computer Language Name History
Click here to see a list of available languages.



Templates
Enter the name of a computer language template file in this field. By default, Editron templates end with 
the extension TML.    For example, a template for the C++ language would be CPP.TML.    Likewise, the 
file PAS.TML would contain a Pascal template.



Templates History
Click here for a list of available language templates.



Comments
Enter the symbol or symbols that mark comments in the current language.    The symbols you enter here 
work with the Match command.    You can enter comment symbols using these formats: 

symbol1
symbol1    &    symbol2
^symbol1    &    symbol2

Here are two examples:

For C/C++:            /* & */      //      ^"&"    ^'&'
For Pascal:            { & }    (* & *) ^'&'

These symbols have special meanings:

&                    Defines a start and stop pair of comment symbols.
^                      Indicates that the comments that follow are for a single character only.



Word Delimiters
In this field, enter the characters that separate words of text.    Editron recognizes these characters when 
you double-click on a word to select it for a cut and paste operation.    Furthermore, these characters 
define the default choice for the search, replace, or find operations.



OK
Click here to close this dialog box and use its language settings.



Cancel
Click here to close the dialog box and use the existing language settings..



Help
Click here to see help information about this dialog box.



Linker Setup Dialog
Configures Editron for use with your linker program.    To learn more, click one of the items on the dialog 
box.



Linker
Enter the name of your linker in this field.    Enter the proper name of the software, not a file name.



Linker List Button
Click here for a list of linkers.    Click on one to work with it.



Path Name
Enter the DOS path and executable file name of the linker.



Command Line
If your linker requires command line arguments, enter them in this optional field.



Command File
If you keep linker command line options in a disk file, enter the files name in this optional field.



Errors Log File
If you want to save linker error messages in a disk file, enter the files name in this optional field.    The log 
file is just for reference; Editron doesnt use it.



Background Linking Toggle
Check here to run the linker as a background task under MS Windows.



Full Size DOS Window Toggle
Check here to run the linker in a full screen DOS session.    This option is recommended for maximum 
linking speeds.



OK
Click here to close this dialog box and use its settings the next time you run your linker from Editron.



Cancel
Click here to close this dialog box and use the existing linker settings.



Delete
Click here to remove the disk file that contains the settings for the current linker.



Help
Click here to see help information on this dialog box.



Load File for Debugger Dialog
Loads a disk file, usually an executable file, and launches the debugger to debug it.    For more 
information, click one of the fields or other controls on the dialog box.



File Name
Enter a file name or a pattern with wildcards in this field.    A complete name specifies a single file to load.  
A pattern with wildcards displays a list of matching files.

Examples of wild card names:
*.exe
*.dll
*.com
*.*
*.
test*.exe
*.exe;*.dll;*.com    (note semicolons)



File Name History
Click here to see a list of the files youve opened during this editing session.



File Name Clear History
Click here to remove the names from the list of previously loaded files.



File Name Extension
Enter a file name extension in this field, preceded by a period. The contents of this field act as a filter for 
the file name field.



File Name Extension List
Click here for a list of file extensions.



File Name Extension Clear List
Click here to remove the entries from the list of file extensions.



List of Files
This box shows files in the current directory.    This list shows the files that match the specifications in the 
file name and extension fields.    Click on a name to select the file.



Directories
This box displays the directory tree structure.    It shows the directories above and beneath the current 
one.    Clicking on a directory name to make it the default.



Directory
This field contains the full path name of the current directory.



Drive
This box shows a scrollable list of drive letters.    Click one to move to the corresponding disk drive.



OK
Click here to load the selected file and debug its contents.



Cancel
Click here to close the dialog box without loading a file into a debugger.



Help
Click here to see help information on this dialog box.



Load Key Map Dialog
Opens a keymap file and uses its keystrokes to control the Editron commands.    By default, the dialog 
box shows files that end with the extension KB.    Editron includes several keymap files.    In addition to its 
own keyboard definition, Editron supports the Borland C, Brief, and MultiEdit keymaps.    Click one of the 
features on the dialog box for more information.



File Name
Enter the name of a keymap file or a wild-card specification in this field.



File Name History
Click here to see a list of keymap files and wild card specifications.



File Name Clear History
Click here to clear the list of keymap files.



File Extension
Enter a file name extension in this field.    The extension acts as a filter for the file name field.



File Extension History
Click here for a drop-down list of file name extensions.



File Extension Clear History
Click here to clear the list of file extension characters.



Files
This box shows the files in the current directory that match the specifications in the name and extension 
fields.    Click a file name to select it.



Directory
This box shows the directory structure.    It displays all the directories above and below the current one.



Directories
This box shows the full path name of the current directory.



Drive
This box shows a list of drive letters.    Click one to move to the corresponding disk.



OK
Click here to close the dialog box and load the selected keymap into Editron.



Cancel
Click here to close the dialog box without loading a keymap.



Help
Click here to see help information about this dialog box.



Load Macro Dialog
Opens a disk file containing a keystroke macro and loads it into memory without executing it. Click one of 
the features on the dialog box for more information.



Macro File
Enter the name of a macro file in this field.



Macro Name
This displays the description of the macro in this field. 



Macro Names List
This list shows the available keystroke macros.    Each line includes the macros file name and English 
description.    Click a line to select the macro.



OK
Click here to close the dialog box and load the selected macro.



Cancel
Click here to close the dialog box without loading a macro.



Delete
Click here to remove the disk file that contains the selected macro.



Help
Click here to see help information on this dialog box.



Macro/Key Binding Dialog
Binds Editron keystrokes to macro files. You can add new keystroke-to-macro bindings or modify existing 
ones.    These bindings are in addition to the existing keystroke-to-command bindings.    Click one of the 
features on the dialog box for more information.    See also the Keystrokes, the Commands. and the 
Keymap Setup dialog.



Current Keymap
This indicates the current keystroke-to-command mapping that is loaded.    An exclamation mark indicates
that it has been modified and not yet saved.



Macro
This column shows a list of Editron macros.    Double-click a command one to edit its associated 
keystrokes.



Primary Key
This column shows the primary keystrokes assigned to the Editron macros.    Double-click one of these 
keystrokes to modify it.



Secondary Key
This column shows the secondary keystrokes assigned to the Editron macros.    Double-click one of these
keystrokes to modify it.



Edit
Select a macro in the list and click this button to edit the associated keystrokes.    You see the Edit 
Keymap dialog box. 



Add
Click here to add a new keystroke-to-macro binding to the current list of macros.    You see the Edit 
Keymap dialog box.



Delete
Click here to delete the items in the selected row: Editron removes the macro and its primary and 
secondary keystrokes from the current keymap.



Find
Press a key and then click inside the dialog box to locate the keystroke in the list of macros.    Editron 
highlights its entry in the list of macros and keystrokes.



Print
Click here to send the current list of keystrokes and commands to the printer.



Load Keymap
Click here to open a keystroke-to-macro binding file and use its keystrokes for this editing session.    You 
see the Load Keymap dialog box.    By default, this dialog box shows files that end with the extension 
KB.    The last keymap you load or save during an Editron session becomes the default for future 
sessions.



Save Keymap
Click here to save the current keymap settings in a disk file.    You see the Save Keymap dialog box.    By
default, this dialog box shows files that end with the extension KB.    The last keymap you load or save 
during an Editron session becomes the default for future sessions.



OK
Click here to close the dialog box and use its current settings.    Note that this button does not 
automatically save a new or modified keystroke-to-macro binding in a disk file.    Use the Save Keymap 
button if you want to work with a new or modified keymap in future Editron sessions. 



Cancel
Click here to close the dialog box and return to the current keymap settings.



Help
Click here to see help information about this dialog box.



Make Utility Setup Dialog
Configures Editron for your make program.    For more information, click one of the fields or other items on
the dialog box.



Make Utility
Enter the name of your make utility in this field.    Be sure to enter the proper name of the software, not a 
file name or extension. 



Make Utility List
Click here for a drop-down list of make programs.    Click one to select it.



Path Name
Enter the DOS path and executable file name of the make utility.



Command Line
This is an optional field for Make Utility command line parameters.



Command File
If you control your make program with a disk file of command line parameters, enter the file name in this 
field.



Errors Log File
If you want a log of the compiler errors that occur during the make process, enter a file name in this 
field.



Compiler
Enter the name of your compiler in this field or choose one from the pull-down list.    Be sure to enter the 
proper name of the software and not a file name or extension.



Compiler List
Click here for a list of compilers.    To work with a compiler, click its name in the list.



Make Background Toggle
Check here to run the make utility as a background task under MS Windows.



Full Size DOS Window Toggle
Check here to run the make utility in a full screen DOS session.    This is recommended for maximum 
execution speeds.



OK
Click here to close this dialog box and use its settings the next time your run your make utility.



Cancel
Click here to close the dialog box and use the existing settings for your make program.



Delete
Click here to remove the disk file that cotains the configuration for the current make utility.



Help
Click here to see help information about this dialog box.



Repeat Dialog
Adds a repetition factor to the next Editron command.    Enter a value, close the dialog box, and then 
execute a command.    Editron runs the command the specified number of times. For more information, 
click the field or other control on the dialog box.



Number
Enter a repetition factor for the next command in this field.    



Number History
Click here to see previous repetition factors.



OK
Click here to close the dialog box and repeat the next command by the specified factor.



Cancel
Click here to close the dialog box.    The next Editron command executes a single time.



Help
Click here for help information on this dialog box.



Replace Dialog
Searches the current buffer for one piece of text and replaces it with another.    For more information, click
on one of the fields or other items in the dialog box.

.



Text To Find
Enter the text you want to find and replace.    You can use regular expression notation to search for 
patterns of text.



Text To Find History
Click here to see a list of text items from previous search operations.



Replace With
Enter the new text to replace the old text.    Be sure to enter literal text without regular expression 
characters.



Replace With History
Click here for a list of text items from previous replacement operations.



Options: Case Sensitive Toggle
If you want Editron to match the capitalization of the entry in the Text To Find field, check this box.



Options: Regular Expression Toggle
If you want to search for patterns of text using regular expression characters, check this box. 



Options: Place Cursor After Toggle
This control determines the position of the cursor after the replacement operation.    Check this box to 
leave the cursor at the end of the replacement text.    Clear it to put the cursor at the start of the text.



Origin: Entire Scope Radio Button
Click here if you want Editron to search the buffer or block from one end to the other.    Use the Scope 
buttons to choose a block or the buffer.



Origin: From Cursor Radio Button
Click here if you want Editron to search the portion of the block or buffer from the cursor position onward.  
Use the Scope buttons to choose a block or the buffer.



Mode: Stop On First Radio Button
Click here to replace the first occurrance of the pattern in the Text To Find field, but none afterwards.



Mode: Prompt For Next Radio Button
Click here if you want Editron to pause after each replacement operation and ask whether you want to 
continue.



Mode: Replace All Radio Button
Click here to automatically replace all occurances of the pattern in the Text To Find field.    Use the Scope 
and Origin buttons to control the search area.



Scope: Global Radio Button
Click here to search the entire buffer.



Scope: Selected Text Radio Button
Click here to search a block of text instead of the whole buffer.



OK Down
Click here to begin the search.    Editron examines the text beneath the point you specify with the Origin 
buttons.



OK Up
Click here to begin the search.    Editron examines the text above the point you specify with the Origin 
buttons.



Cancel
Click here to close the dialog box without searching for or replacing text.



Help
Click here for help information on this dialog box.



Run Dialog
Executes any DOS or MS Windows program. For more information, click the field or other control on the 
dialog box.



Command Line
Enter the executable file name of an MS Windows or DOS program in this field.    Enter the full DOS path 
if it is not included in the PATH environment variable.



Command Line History
Click here for a list of previous programs.



Run Minimized Toggle
Check here to run the program as an icon on the desktop.



OK
Click here to close the dialog box and run the specified program.



Cancel
Click here to close the dialog box without running a program.



Scan
If you want Editron to search for executable programs, click here.    You see the File Open Dialog.



Help
Click here for help information on this dialog box.



Save Block As Dialog
Saves a block of text in a disk file.    For more information, click on one of the fields or other items in the 
dialog box.



Save As Filename
Enter the name of the file to receive the selected text.



Directories
This box shows the directory structure.    It displays all the directories above and below the current one. 



Directory
This box contains the full path name of the current directory.



Drive
This box shows list of drive letters.    Click one to move to the corresponding disk drive.



OK
Click here to close the dialog box and save the block of text in a disk file.



Cancel
Click here to close the dialog box without saving the block of text.



Help
Click here to see help information on this dialog box.



Save Buffer As Dialog
Saves the contents of the current buffer in a disk file.    For more information, click on one of the fields or 
other items in the dialog box.



Save As Filename
Enter the name of the file to receive the contents of the buffer.



Directories
This box shows the directory structure.    It displays all the directories above and below the current one.



Directory
This box contains the full path name of the current directory.



Drive
This box shows list of drive letters.    Click one to move to the corresponding disk drive.



OK
Click here to close the dialog box and save the buffer in a disk file.



Cancel
Click here to close the dialog box without saving the buffer.



Help
Click here to see help information on this dialog box.



Save Keymap As Dialog
Saves the current keymap in a disk file.    Once you save a keymap, it stays in effect until the next time 
you use the Save Keymap or Load Keymap function.    For more information, click on one of the fields or 
other controls in the dialog box.



Save As Filename
Enter the name of a file to hold the current keymap.



Directory
This box shows the full DOS path name of the current directory.



Directories
This box shows the structure of the directory tree.    It displays all the directories above and below the 
current one.



Drive
This box contains a list of drive letters.    Click one to move to the corresponding disk drive.



OK
Click here to close the dialog box and save the current keymap in the specified disk file.



Cancel
Click here to close the dialog box without saving the keymap.



Help
Click here to see help information on this dialog box.



Save Macro Dialog
Saves the commands in the current macro in a disk file.    For more information, click on one of the fields 
or other controls in the dialog box.



Macro File
Enter a DOS file name for the keystroke macro in this field.



Macro Name
Enter a descriptive title for the macro in this field.



Macro Names List
This box shows a macro files in the current disk directory.



OK
Click here to close the dialog box and save the macro in a file.



Cancel
Click here to close the dialog box without saving the macro.



Delete
Click here to remove the disk file that contains the current macro.



Help
Click here for help information on this dialog box.



Search Dialog
Looks for a piece of text in the current buffer.    For more information, click on one of the fields or other 
controls in the dialog box.



Text To Find
Enter the text you want to find in this field.    You can include regular expression symbols which match 
patterns of text.



Text To Find History
Click here to see a list of items from previous search operations.



Options: Case Sensitive Toggle
Check here if you want Editron to match the capitalization in the Text To Find field.



Options: Regular Expression Toggle
Check here if you want to use regular expressions to search for patterns of text.    If you dont need this 
capability, clear the box for faster searching.



Options: Place Cursor After Toggle
This control determines the position of the cursor after the search operation.    Check this box to leave the 
cursor at the end of the text.    Clear it to put the cursor at the start of the text.



Origin: Entire Scope Radio Button
Click here if you want Editron to search the buffer or block from one end to the other.    Use the Scope 
buttons to choose a block or the buffer.



Origin: From Cursor Radio Button
Click here if you want Editron to search the portion of the block or buffer from the cursor position onward.  
Use the Scope buttons to choose a block or the buffer.



Mode: Stop On First Radio Button
Click here to find the first occurrance of the pattern in the Text To Find field, but none afterwards.



Mode: Prompt For Next Radio Button
Click here if you want Editron to pause after it finds matching text.    During the pause, you see a prompt 
asking whether you want to continue the search operation.



Mode: Find All
Check here if you want to search for all the items that match the pattern in the Text To Find field.    Editron 
displays the total in a dialog box.



Scope: Global Radio Button
Click here to search the entire buffer.



Scope: Selected Text Radio Button
Click here to search the highlighted block.



OK Down
Click here to begin the search.    Editron examines the text beneath the point you specify with the Origin 
buttons.



OK Up
Click here to begin the search.    Editron examines the text above the point you specify with the Origin 
buttons.



Cancel
Click here to close the dialog box without initiating a search.



Help
Click here to see help information on the dialog box.



Setup Dialog
Configures many of Editrons global options.    For more information, click on one of the controls in the 
dialog box.



Edit Styles: Insert Mode Toggle
Check here to use insertion as the default mode for typing.    Clear the box for overwrite mode.



Edit Styles: Cursor Through Tab Toggle
This checkbox controls the behavior of the cursor as you move it through a tab.    If the box is clear, you 
can move through the tab with a single keystroke.    If the box is checked, the cursor behaves as if the tab 
were composed of an appropriate number of space characters.



Edit Styles: Cursor Group Undo Toggle
This checkbox controls the behavior of the Undo function.    If this box is checked, Undo treats a 
sequence of related commands as a group and reverses them all at once.    For instance, if you press the 
delete key five times, a single Undo command restores the last five keystrokes    If this checkbox is clear, 
Undo only reverses the effect of the last keystroke.    This control governs insertions, deletions, 
overstrikes, and cursor movements.



Edit Styles: Scroll With Cursor Toggle
This control governs the behavior of the cursor as you scroll the text in a window.    If the box is checked, 
the cursor remains in the window.    If its unchecked, the cursor remains anchored even if you scroll it out 
of the window. In this case, you must bring the cursor back in view manually using the mouse or another 
technique.



Edit Styles: Close Bookmark Toggle
Check here to clear the Go To Bookmark dialog box from onscreen after you jump to a bookmark.    If it 
is unchecked, the dialog remains onscreen after you jump to a bookmark.



Edit Styles: Mouse CUA Selection Toggle
Check here if you want Editron to obey the IBM CUA (Common User Access) guidelines for mouse 
behavior, block selection, and so forth.



Edit Styles: Words Wrap Toggle
This control governs the default behavior of the cursor as you type the text in a window.    If the box is 
checked, the cursor will wrap the sentence to the next line when it reaches the right margin.    Whole 
words are preserved when the sentence is wrapped.    If it is unchecked, the cursor remains on the same 
line even if you type past the right margin.    See also the Tabs dialog and the Tools menu.



Edit Styles: Accumulative Scrap Toggle
Check here if you want Editron to preserve the contents of the scrap after every cut or copy operation.    
Each operation appends new text to the bottom of the scrap. If the box is clear, Editron clears the scrap 
every time you cut or copy text.



Indent Styles: Auto Indent Toggle
Check this box to enable automatic indentation.    If this feature is active, Editron automatically indents a 
new line of text to match the previous lines indentation.



Indent Styles: Smart Language Indent Toggle
Check this box to use the indentation style of a programming language.    If this is feature is active, Editron
lines up the braces in a C program, the BEGIN and END keywords in a Pascal program, and so forth.    
See also the Language dialog and the format of the Language template file.



Indent Styles: Backspace Unindent Toggle
Check here if you want to delete consecutive tab or space characters with one backspace operation.    If 
this box is clear, the backspace key erases one space or tab at a time.



Mouse Cursor Shape: Hand Cursor Radio Button
Check here if you want the mouse text cursor to be a hand with a pointing finger.



Mouse Cursor Shape: I-Beam Cursor Radio Button
Check here if you want the mouse text cursor to be an I-beam shape.



Toolbar Style: Off Radio Button
Click here to hide the toolbar.



Toolbar Style: Horizontal Bar Radio Button
Click here to display a horizontal toolbar beneath the Editron menu.



Toolbar Style: Vertical Bar Radio Button
Click here to display a vertical toolbar at the right edge of the Editron window.



Toolbar Style: Popup Dialog Vertical Radio Button
Click here to display the toolbar as a floating palette with two columns of buttons.



Toolbar Style: Popup Dialog Square Radio Button
Click here to display the toolbar as a floating, square palette.



Toolbar Style: Popup Dialog Horizontal Radio Button
Click here to display the toolbar as floating, horizontal palette with two rows of buttons.



Toolbar Style: Large Buttons Radio Button
Click here to place standard-sized buttons on the tool bar .



Toolbar Style: Small Buttons Radio Button
Click here to place small buttons on the tool bar.



New Window Styles: Line Numbers Toggle
Check here to display line numbers by default in a new window.



New Window Styles: Tab Ruler Toggle
Check here to display the Tab Ruler by default in a new window.



New Window Styles: Always Normal Size Toggle
Check here to allow new windows to be automatically normal if the current window is maximized.



Advanced Setup Dialog Button
Click here to see the Advanced Setup box.    This window offers other features for Editron configuration.



OK
Click here to close the dialog box and use its settings in the current Editron session and future sessions.



Cancel
Click here to close this dialog box and use the existing configuration for Editrons global settings.



Help
Click here for help information on this dialog box.



Tabs Dialog
Sets tab stops and right margins for a particular computer language.    For more information, click on one 
of the fields or other controls in the dialog box.



Show Tabs Toggle
Check this box if you want Editron to show a visible tab character in the text.



Use Spaces Toggle
Check here if you want Editron to substitute an appropriate number of space characters for each tab.



File Extension
Enter the extension that you use with source code files for a particular language.    For example, enter 
CPP for files of C++ code.    Editron uses this extension to determine the appropriate formatting and 
compiler options.



File Extension List
Click here for a pull-down list of file name extensions.    Choose one to represent a particular computer 
language.



Language
Enter the name of a programming language in this field.    Editron stores tab stops and other information in
a template for this language.    Be sure to enter the proper name of the language and not a file name.



Language List
Click here to see a pull-down list of programming languages.



Language Setup Button
Click here to see the Language dialog box.    This window offers other features for programming support.



Tab Size
Enter the width in characters of a tab.



Tab Ruler
This line shows the column position of the first six or more tab stops on the tab ruler.    This can be edited 
or updated by the Set Tab Ruler Button.



Use Tab Ruler Toggle
Check here if you want Editron to use the tab ruler instead of a fixed array of tab stops based on the tab 
size and multiplier.



Set Tab Ruler Button
Click here to adjust the settings in the tab ruler.    The new tab interval equals the product of the value in 
the Tab Size field and the multiplier in the field to the right of this button.



Multiply Tab Size by This Number
Enter a multiplier for the default tab size in this field.



Right Margin
Enter the number of the column that defines the right hand margin.    This feature is useful for word 
wrapping and centering text.



OK
Click here to close the dialog box and use its tab settings.



Cancel
Click here to close the dialog box and use the existing tab settings. 



Help
Click here to see help information on this dialog box.



Printer Setup Dialog
Displays the MS Windows printer setup dialog box.    The contents of this window depend on your printer. 



Unassigned Keys Dialog
Displays a list of unassigned keystrokes.    For more information, click on one of the features in the dialog 
box.



Key Names
This list shows the keystrokes that arent assigned to an Editron command or macro.



OK
Click here to use the selected keystroke and close the dialog box.



Help
Click here to see help information on this dialog box.



Windows Selection Dialog
Selects an edit window.    This dialog box provides a handy way of changing to another window.    For 
more information, click one of the fields or other controls on the dialog box.



List of Edit Windows
This list shows the edit windows.    Click a window name to select it.    The asterix (*) indicates that the 
underlying buffer has been modified and not saved.    Hidden windows are indicated by the word "hidden" 
in angle brackets (<hidden>).



OK
Click here to close the dialog box and to accept the selected window.



Cancel
Click here to close the dialog box and return to the current edit window.



Help
Click here to see help information on this dialog box.



Commands

This list shows the Editron commands.    There are six ways to issue a command: 

-- Press a keystroke sequence
-- Select a menu item
-- Click the mouse
-- Press a tool bar button
-- Run a macro
-- Use the Commands dialog box

applications_dlg 
arrange_icons 
beginning_of_line 
break 
buffer_list 
calculator 
cascade 
case_toggle 
center_in_N_cols    
center_in_win 
change_directory_dlg 
char_map 
clip_scrap 
close_all
close_block 
colors_dlg 
compile 
compiler_setup 
copy_block 
copy_to clip 
copy_to_clip_scrap
cut_to_clip 
cut_to_clip_scrap 
cut_to_scrap 
debugger 
debugger_setup 
delete_block 
delete_char_block 
delete_file_dlg 
delete_line 
delete_next_char 
delete_next_word 
delete_previous_char 
delete_previous_word 
delete_to_EOL 
directory_list 
down 
drop_bookmark_dlg 
edit_keymap_dlg 
end_of_buffer 
end_of_line 
end_of_window 
exec_keystroke_macro_dlg 
exit 



fill_block_dlg 
find_dlg 
fonts_dlg 
get version 
go_mark_0 
go_mark_1 
go_mark_2 
go_mark_3 
go_mark_4 
go_mark_5 
go_mark_6 
go_mark_7 
go_mark_8 
go_mark_9 
goto_bookmark_dlg 
goto_line_dlg 
help_commands 
help_dialogs 
help_index 
help_keyboard 
help_menus 
help_tool_bar 
help_using 
hex_char
hide_window 
indent_block 
insert_date 
insert_file 
insert_filename 
insert_mode 
insert_new_line 
insert_time 
inter window_copy_block 
inter window_move_block 
language_dlg 
last_srch_repl_back 
last_srch_repl_forw 
left 
left_side 
line_to_bottom 
line_to_top 
link 
linker_setup_dlg 
load_keystroke_macro_dlg 
macro_key_binding_dlg 
make 
make_util_setup_dlg 
match 
move_block 
new_buffer 
next_error 
next_window 
next_word 
null 
numbers_toggle 
open_close_block 



open_file_dlg 
open_line 
outdent_block 
page_down 
page_up 
paste_from_clip 
paste_from_clip_scrap 
paste_from_scrap 
pause_recording 
playback 
previous_error 
previous_window 
previous_word 
print_block 
print_buffer 
print_buffer_block 
print_dlg 
printer_setup_dlg 
record_toggle 
redo 
reform_all 
reform_block 
reg_toggle 
repeat 
repeat_dlg 
replace_again 
replace_back 
replace_dlg 
replace_fwd 
right 
right_side 
run_dlg 
save_all 
save_buffer 
save_buffer_as dlg    
save_buf_block 
save_close 
save_exit 
save_keystroke_macro_dlg    
save_layout 
save_setup 
scroll_down 
scroll_left 
scroll_right 
scroll_up 
sdk_help 
sdk_help key 
search_again 
search_back 
search_dlg 
search_fwd 
select_box 
select_line 
select_stream 
set_mark_0 
set_mark_1 



set_mark_2 
set_mark_3 
set_mark_4 
set_mark_5 
set_mark_6 
set_mark_7 
set_mark_8 
set_mark_9 
setup_dlg 
shell 
show_macro_buffer 
show_scrap 
tab_insert 
tab_ruler 
tabs_dlg 
tile 
tile_horiz 
tile_vert 
toolbar_toggle 
to_lowercase 
to_uppercase 
top_of_buffer 
top_of_window 
unassigned_keys_dlg 
undo 
unselect_block 
up 
use_spaces_toggle 
wordwrap_toggle 
write_block
zoom_window 



Applications Dialog
applications_dlg: Brings up the Applications dialog box. You can run or set up various external utilities 
like the calculator or an SDK help file.



Arrange Icons
arrange_icons: Organizes document icons in the Editron window so they are neatly arranged..



Back Tab
back_tab: Inserts the back tab character.



Back Space
backspace: Inserts the back space character.



Beginning of Line
beginning_of_line (<HOME>): Moves the cursor to the first character of the current line.

Special case: If you map a keystroke to this command, typing it twice enters the top_of_window 
command.    Typing it three times enters the top_of_buffer command.



Break
break (ctrl-<CANCEL> or ctrl-<BREAK>): Terminates the currently executing command.    Use Break to 
end commands that are taking too long to finish.



Buffer List
buffer_list: Displays a list of all the buffers in Editron.    See also the Windows Selection dialog.



Calculator
calculator (alt-C): Runs the calculator program.



Cascade Windows
cascade: Stacks the open windows, keeping all title bars visible.



Case Sensitivity Toggle
case_toggle: Changes how a text search treats capitalization.    If the search is case sensitive, Editron 
looks for text that matches both upper and lower case.    Otherwise, Editron ignores capitalization.



Center Line in N Columns
center_in_N_cols: Centers the current line between the left and right margins.



Center Line in Window
center_in_win: Centers the current line between the left and right borders of the document window.



Change Directory Dialog
change_directory_dlg: Brings up the Change Directory dialog box so you can switch to another drive or 
subdirectory.



Character Map
char_map:  Runs the character map program.



Clipboard or Scrap Buffer Toggle
clip_scrap: Changes where Editron temporarily stores text.    The Clipboard is the standard tool available 
to all Windows applications.    The Scrap is Editrons local holding area. Use it to move text around a single
document or between two Editron documents.



Close All Buffers
close_all: Closes all open buffers.    All windows and icons disappear.



Close Block Selection
close_block (ctrl-Y): Closes a block of text. Until you close a block, every click of the mouse redefines it.



Colors Preferences Dialog
colors_dlg: Brings up the Color Preferences dialog box so you can change Editron's color scheme.



Compile
compile (ctrl-<F10>): Runs a language compiler and compiles the source code in the current buffer.    The 
buffers file name extension determines which compiler Editron runs.    For example, if you compile a buffer
labeled TEST.C, Editron runs the C compiler.    Compiling TEST.PAS runs the Pascal compiler.    Use the 
Compiler Setup dialog box to configure Editron for your programming language compiler.



Compiler Setup Dialog
compiler_setup_dlg: Lets you configure Editron for your programming language compiler using the 
Compiler Setup dialog box.



Copy Selected Block
copy_block: Copies a selected block to a new location in the current buffer.    It is recommended that you 
uncheck the Mouse CUA Selection toggle in the Setup dialog when using this command.



Copy To Clipboard
copy_to_clip: Copies the selected block to the Clipboard.



Copy to Clipboard or Scrap Buffer
copy_to_clip_scrap (ctrl-C, ctrl-<INS>): Copies the selected block to the Scrap or Clipboard.    The 
destination of the text depends on the setting of the Select Scrap/Clipboard option on the Edit menu.



Copy To Scrap Buffer
copy_to_scrap: Copies the selected block to the Scrap.



Cut To Clipboard
cut_to_clip: Removes the selected block and places it on the Clipboard.



Cut to Clipboard or Scrap Buffer
cut_to_clip_scrap (ctrl-X, shift-<DEL>): Removes the selected block and places it on the Scrap or 
Clipboard.    The destination of the text depends on the setting of the Select Scrap/Clipboard option on the
Edit menu.



Cut To Scrap Buffer
cut_to_scrap: Removes the selected block and places it on the Scrap.



Debugger
debugger (alt-<F10>): Runs a debugger program.    Use the Debugger Setup dialog box to configure 
Editron for your debugging software.



Debugger Setup Dialog
debugger_setup: Lets you configure Editron for your debugging software using the Debugger Setup 
dialog box.



Delete Block
delete_block: Eliminates the selected block and places it on the Scrap or Clipboard.



Delete Character Block
delete_char_block: Eliminates the selected block and does not place it on the Scrap or Clipboard.



Delete File Dialog
delete_file_dlg (alt-<F7>): Lets you select and delete a file or group of files on the Delete File dialog box.



Delete Line
delete_line (ctrl-D): Eliminates the current line.



Delete Next Character
delete_next_char (<DEL>): Eliminates the character to the right of the cursor.



Delete Next Word
delete_next_word (ctrl-<DEL>): Eliminates the word to the right of the cursor.



Delete Previous Character
delete_previous_char (<BSP>): Eliminates the character to the left of the cursor.



Delete Previous Word
delete_previous_word (ctrl-<BSP>): Eliminates the word to the left of the cursor.



Delete to End of Line
delete_to_EOL (alt-<DEL>): Eliminates the characters from the right of the cursor to the end of the line.



Directory List Dialog
directory_list (ctrl-<F7>): Brings up the Directory Tree dialog box displaying a graphical representation of 
the directory tree on the disk.



Down
down (<DOWN>): Moves the cursor to the next line in the same column.



Drop Bookmark Dialog
drop_bookmark_dlg (ctrl-<F5>): Lets you place a bookmark at the cursors current position using the Drop
Bookmark dialog box.



Edit Keymap Dialog
edit_keymap_dlg: Lets you edit, delete, or add keystroke command mappings on the Edit Keymap 
dialog dialog box.



End of Buffer
end_of_buffer (ctrl-<END>): Moves the cursor to the last character in the buffer.



End of Line
end_of_line (<END>): Moves the cursor to the last character of the current line.

Special case: If you map a keystroke to this command, typing it twice enters the end_of_window 
command.    Typing it three times enters the end_of_buffer command.



End of Window
end_of_window: Moves the cursor to the last character in the window.



Execute Command Dialog
Brings up the Execute Command dialog box so you can enter a command by selecting it from a list.



Execute Keystroke Macro Dialog
exec_keystroke_macro_dlg: Prompts you for the name of a macro.    Choose a file on the Execute 
Keystroke Macro dialog box.    Then click OK to execute the commands in the macro file.



Exit
exit (alt-<F4>, alt-X): Closes Editron and returns to Windows.



Fill Block Dialog
fill_block_dlg: Lets you fill a highlighted block with a pattern of characters. Enter the characters in the Fill 
Block dialog box.



Find Files Dialog
find_dlg (ctrl-F, <F7>): Lets you search for text in the current buffer or disk files. See also: the Find Files 
dialog box.



Fonts Dialog
fonts_dlg: Lets you change the size, style, or font of the display text.    See also: the Fonts dialog box.



Get Version
get_version (alt-V): Displays the About dialog with the version number for your copy of Editron.



Go To Book Mark
go_mark_0, go_mark_1, ..., go_mark_9 (ctrl-0, ctrl-1,...,ctrl-9): Moves the cursor to one of the ten 
numbered bookmarks in the current buffer.



Go To Bookmark Dialog
goto_bookmark_dlg (<F5>): Prompts you for the number of a bookmark. Click one of the numbered 
buttons on the Go To Bookmark dialog box to move the cursor to the corresponding bookmark.



Go To Line Dialog
goto_line_dlg (alt-<F5>): Prompts you for a line number. Enter a number on the Go To Line dialog box 
and click OK to move to the corresponding line.



Help Commands
help_commands: Brings up the section of Editron help describing the commands (this section).



Help Dialogs
help_dialogs: Brings up the section of Editron help describing the dialogs.



Help Index
help_index (<F1>): Brings up the main contents of the Editron help system.



Help Keyboard
help_keyboard: Brings up the section of Editron help describing the standard keyboard 
layout.



Help Menus
help_menus: Brings up the section of Editron help describing the menus.



Help Tool Bar
help_tool_bar: Brings up the section of Editron help describing the menus.



Help Using Editron
help_using: Brings up the section of Editron help describing how to use Editron.



Hex Value of Character
hex_char: Displays the hexadecimal value of the character the buffer cursor is resting on.



Hide Window
hide_window: Hides the current window.    This is different from minimization; there is no icon.    To restore 
it select it from the Windows menu.



Indent Block
indent_block: Moves a block one tab stop to the left.



Insert Date
insert_date: Places the date at the cursor position.



Insert File
insert_file: Prompts you for the name of a file to open and insert into the current buffer at the buffer cursor
location. Choose a file on the File Open dialog box and click OK to insert its contents.



Insert Filename
insert_filename: Places the current buffers filename at the cursor position.



Insert Mode
insert_mode (<INS>): Toggles the typing mode between insert and overwrite.



Insert New Line
insert_new_line (<ENTER>): Adds a new line at the cursor position.    This command may split the current
line into two lines.



Insert Time
insert_time: Places the time at the cursor position.



Inter window Copy Block
inter_window_copy_block: Copies a block between two buffers without using the Scrap or Clipboard.



Inter window Move Block
inter_window_move_block: Moves a block between two buffers without using the Scrap or Clipboard.



Language Setup Dialog
language_dlg: Lets you configure Editron for a programming language using the Language Setup dialog
box.    You can specify an editing template and other features for a particular language.



Last Search or Replace Backward
last_srch_repl_back: Repeats the last search or replace command backward from the current cursor 
position.



Last Search or Replace Forward
last_srch_repl_forw: Repeats the last search or replace command forward from the current cursor 
position.



Left
left (<LEFT>): Moves the cursor left one character.



Left Side
left_side (shift-<HOME>): Moves the cursor to the left edge of the window.



Line to Bottom
line_to_bottom: Moves the current line to the bottom of the window.



Line to Top
line_to_top (ctrl-T): Moves the current line to the top of the window.



Link
link (ctrl-shift-<F10>): Binds the program in the active window with its libraries and associated modules.    
Use the Linker Setup dialog box to configure Editron for your linker.



Linker Setup Dialog
linker_setup_dlg: Lets you configure Editron for your linker using the Linker Setup dialog box.



Load Keystroke Macro Dialog
load_keystroke_macro_dlg:    Lets you load an existing keystroke command mappings stored on the Load
Keystroke Macro dialog dialog box.



Macro/Key Binding Dialog
macro_key_binding_dlg: Lets you associate a keystroke with a macro using the Macro/Key Binding 
dialog box.



Make
make (<F10>): Builds a system by selectively compiling and linking component modules. Use the Make 
Utility Setup dialog box to configure Editron for your make utility.



Make Utility Setup Dialog
make_util_setup_dlg: Lets you configure Editron for your make utility using the Make Utility Setup dialog
box.



Match
match (ctrl-shift-M): Locates the symbol that matches the one at the current cursor position.    For 
example, you can match brackets and parentheses in C source code.    See also the Tools menu, Tool 
Bar, and Languages Setup dialog.



Move Selected Block
move_block: Moves a selected block to a new location in the current buffer.    It is recommended that you 
uncheck the Mouse CUA Selection toggle in the Setup dialog when using this command.



New Buffer
new_buffer: Creates a new buffer and displays it in a window.



Next Error
next_error (<F11>): Moves the cursor to the next compiler error.    See also Compiler Error Formats and 
Compiler Setup dialog.



Next Window
next_window (ctrl-N): Moves the cursor to the next window.



Next Word
next_word (ctrl-<RIGHT>): Moves the cursor to the next word on the current line.



Null
null (<ESC>): This command does nothing.



Numbers Toggle
numbers_toggle (<F6>): Shows or hides line numbers in the current buffer.



Open Or Close Block Selection
open_close_block: Either finishs the selection of a block of text or reopens it for further adjustment.



Open File Dialog
open_file_dlg (ctrl-<F9>, ctrl-O): Prompts you for the name of a file to edit. Choose a file on the File Open
dialog box and click OK to edit its contents. Editron creates a new buffer to hold the file and displays its 
contents in a new window.    If the file is already open, Editron creates a new window into the existing 
buffer.    This technique lets you create multiple windows that show different parts of a program or 
document.



Open Line
open_line (ctrl-<ENTER>): Creates a new line beneath the current line.



Outdent Block
outdent_block (shift-<TAB>): Moves a block one tab stop to the right.



Page Down
page_down (<PGDN>): Scrolls the text in a window down by one page. The size of the page equals the 
height of the window.



Page Up
page_up (<PGUP>): Scrolls the text in a window up by one page. The size of the page equals the height 
of the window.



Paste from Clipboard
paste_from_clip: Copies text from the Clipboard to the current buffer at the cursor position.



Paste from Clipboard or Scrap Buffer
paste_from_clip_scrap (ctrl-V, shift-<INS>): Copies text from the Clipboard or the Scrap to the current 
buffer at the cursor position.    The source of the text depends on the setting of the Select Scrap/Clipboard
option on the Edit menu.



Paste from Scrap Buffer
paste_from_scrap: Copies text from the Scrap to the current buffer at the cursor position.



Pause On Recording
pause_recording (alt-<F8>): Inserts a pause during playback of a keystroke macro.    The pause allows 
the user to insert data or commands before the macro resumes.



Playback
playback (<F8>): Replays the keystrokes and command in the current macro.



Previous Error
previous_error (ctrl-<F11>):    Moves the cursor to the line of source code that corresponds to the previous
error in the compiler error window. See also: Compiler Error Formats and Compiler Setup dialog.



Previous Window
previous_window (ctrl-P): Moves the cursor to the previous window.



Previous Word
previous_word (ctrl-<LEFT>): Moves the cursor to the previous word.



Print Buffer
print_buffer (alt-P): Prints the current buffer.



Print Block
print_buffer_block: Prints a selected block within the current buffer.



Print Buffer Block
print_buffer_block: Prints a selected block within the current buffer, otherwise if there is no block selected 
the entire buffer.



Print Dialog
print_dlg: Starts the MS Windows print command. 



Printer Setup Dialog
printer_setup_dlg: Starts the MS Windows printer setup command.



Record Toggle
record_toggle (ctrl-<F8>): Records keystrokes for later playback as a macro.    After you run this 
command the first time, Editron saves all your keystrokes in memory. Use it again to end the recording 
process.



Redo
redo (ctrl-A, alt-<INS>): Reverses the effect of the last undo command.



Reformat All
reformat_all: Word wraps all the text in the current buffer so each line does not extend past the right 
margin. 



Reformat Block
reformat_block: Word wraps all the text in a highlighted block so each line does not extend past the right 
margin. 



Regular Expression Toggle
reg_toggle: Enables or disables regular expressions during search operations. When this option is on, 
you can search for patterns of text that include regular expressions.



Repeat
repeat (alt-shift-R): Repeats the last command. If the command has a repetition factor, Editron runs it the 
appropriate number of times.



Repeat Dialog
repeat_dlg: Prompts you for a repetition factor on the Repeat dialog box. This value tells Editron to 
execute the next command the appropriate number of times.



Replace Again
replace_again (ctrl-shift-R): Repeats the last replacement operation.    Editron uses the current entries in 
the Replace dialog to find a pattern of text and replace it with new text. 



Replace Backward
replace_back (ctrl-<F3>): Repeats the last replacement operation by searching backward through the 
text.    Editron uses the current entries in the Replace dialog to find a pattern of text and replace it with 
new text.



Replace Dialog
replace_dlg (ctrl-R): Initiaties the search and replace operation.    This command produces the Replace 
dialog that prompts you for a pattern of text and its replacement.



Replace Forward
replace_fwd (<F3>): Repeats the last replacement operation by searching forward through the text.    
Editron uses the current entries in the Replace dialog to find a pattern of text and replace it with new text.



Right
right (<RIGHT>): Moves the cursor right one character.



Right Side
right_side (shift-<END>): Moves the cursor to the right edge of the window.



Run Dialog
run_dlg (ctrl-shift-<F4>): Prompts you for the name of an executable DOS or Windows program. Enter the
programs name in the Run dialog and click OK. 



Save All
save_all (alt-<F9>): Saves all buffers in disk files.



Save Block As Dialog
save_buf_block (ctrl-shift-W): Lets you specify a disk file for the selected block.    Enter a name in the 
Save Block As dialog box and click OK to save the contents of the buffer in the specified file.



Save Buffer
save_buffer (<F9>, ctrl-W): Saves the contents of the current buffer in the corresponding disk file.    If the 
buffer does not have a file, Editron displays the Save Buffer As dialog box to prompt for a file name.



Save Buffer As Dialog
save_buffer_as_dlg: Lets you specify a disk file for the current buffer.    Enter a name in the Save Buffer 
As dialog box and click OK to save the contents of the buffer in the specified file.



Save Buffer Block
save_buf_block: Saves the contents of the selected block, otherwise if there is no block selected the 
entire buffer, in the corresponding disk file. Editron displays the Save Buffer As dialog or the Save Block
As dialog box to prompt for a file name.



Save Close
save_close (ctrl-shift-<F9>): Saves the current buffer and closes its window.    If you have multiple 
windows for a single buffer, this command closes the current window, keeps the others onscreen, and 
retains the buffer in memory.



Save Exit
save_exit: Saves all buffers in disk files, closes Editron and returns to Windows.



Save Keystroke Macro Dialog
save_keystroke_macro_dlg: Lets you save the current keystroke macro in a disk file.    Enter a file name 
in the Save Macro dialog.



Save Layout
save_layout: Saves the current state of all the windows, icons, buffers, cursor positions, and text 
selections.



Save Setup
save_setup: Saves the current system settings including fonts, colors, etc.



Scroll Down
scroll_down (ctrl-<DOWN>): Moves the text in a window down by half a page. The size of the page 
equals the height of the window.



Scroll Left
scroll_left: Moves the text in a window to the left by half the width of the window.



Scroll Right
scroll_right: Moves the text in a window to the right by half the width of the window.



Scroll Up
scroll_up (ctrl-<UP>): Moves the text in a window up by half a page. The size of the page equals the 
height of the window.



SDK Help
sdk_help (ctrl-shift-<F1>): Runs the help system for your software development kit.



SDK Help Keyword
sdk_help_key (ctrl-<F1>): Place the cursor over a key word in your text.    This runs the help system for 
your software development kit and brings up context sensitive help information.



Search Again
search_again (ctrl-shift-S): Repeats the last search operation. Editron uses the current entries in the 
Search dialog to find a pattern of text.



Search Backward
search_back (ctrl-<F2>): Repeats the last search operation, moving backward through the text.    Editron 
uses the current entries in the Search dialog to find a pattern of text.



Search Dialog
search_dlg (ctrl-S): Starts a search operation. Enter a pattern of text on the Search dialog and click OK. 
Editron scans the current buffer and finds the first piece of text that matches the specified pattern.



Search Forward
search_fwd (<F2>): Repeats the last search operation, moving forward through the text.    Editron uses 
the current entries in the Search dialog to find a pattern of text.



Select Box
select_box (ctrl-B): Defines one corner of a box block. Move the mouse pointer to the opposite corner and
click the button to highlight a box of text.



Select Line
select_line (ctrl-L): Defines one end of a line block. Move the mouse pointer to the other end and click the 
button to highlight a block of lines.



Select Stream
select_stream (ctrl-M): Defines one end of a stream block. Move the mouse pointer to the other end and 
click the button to highlight a continuous stream of text.



Set Bookmark
set_mark_0, set_mark_1, ..., set_mark_9 (alt-0, alt-1,...,alt-9): Sets one of the ten numbered bookmarks 
at the current cursor position.



Setup Dialog
setup_dlg: Lets you configure Editrons global parameters on the Setup dialog box.



Shell (DOS)
shell (<F4>): Runs a DOS session. You can run DOS in a window or give it the full screen.    See also the 
DOS menu item in the File menu.



Show Macro Buffer
show_macro_buffer: Displays the contents of the keystroke macro buffer.



Show Scrap
show_scrap: Displays the contents of the scrap buffer.



Tab Insert
tab_inset (<TAB>): Inserts a tab character, or an equivalent number of spaces, at the current cursor 
position. The cursor moves to the next tab stop.



Tab Ruler
tab_ruler (ctrl-shift-<F6>): Displays or hides the tab ruler in the current window.    The tab ruler shows the 
location of the tab stops and the right margin.    See also: the Tabs Setup dialog box, the Tools menu, 
and the Tool bar.



Tabs Dialog
tabs_dlg: Lets you set tab stops, margins, and other editing options on the Tabs dialog box. 



Tile
tile: Places multiple windows adjacent to one another.    Each window gets an equal amount of space.



Tile Horizontally
tile_horiz: Places multiple windows left to right across the Editron screen. Each window gets an equal 
amount of space. 



Tile Vertically
tile_vert: Places multiple windows top to bottom along the Editron screen. Each window gets an equal 
amount of space.



To Lowercase
to_lowercase (ctrl-shift-D): Converts all highlighted text to lowercase.



To Uppercase
to_uppercase (ctrl-shift-U): Converts all highlighted text to uppercase.



Tool Bar Toggle
toolbar_toggle (alt-<F6>): Displays or hides the tool bar.



Top of Buffer
top_of_buffer (ctrl-<HOME>): Moves the cursor to the first line in the buffer.



Top of Window
top_of_window: Moves the cursor to the first line in the window.



Unassigned Keys Dialog
unassigned_keys_dlg: Displays the Unassigned Keys dialog box, which shows a list of keystrokes that 
arent associated with a command or macro. Use this list as a reference to find available keystrokes.



Undo
undo (ctrl-Z, alt-<BSP>): Reverses the effect of the last command.



Unselect Block
unselect_block (ctrl-U): Clears a block. The highlighted text in the block returns to normal.



Up
up: Moves the cursor up one line.



Use Spaces Toggle
use_spaces_toggle: Tells Editron to insert a series of space characters in the text when you press the tab 
key. The alternative is a tab character.



Word Wrap Toggle
wordwrap_toggle: Switches paragraph formatting on and off.    When this setting is on, Editron 
automatically skips to the next line when you type a word that crosses the right margin. Editron moves the
word to the next line and does not insert an end-of-line character.    This function is mainly useful for 
creating paragraphs of prose.



Write and Exit
write_and_exit: Saves the current buffer in its disk file and exits Editron.



Write Block
write_block: Saves the contents of the selected block in the corresponding disk file. Editron displays the 
Save Buffer As dialog box to prompt for a file name.



Zoom Window
zoom_window (alt-Z): Maximizes the current normal sized window or restores a maximixed window.



Menus
These are the Editron menus:

Blocks Submenu 
Edit Submenu 
Files_Submenu 
Go To Submenu 
Help Submenu 
Macro Submenu 
Options Submenu 
Search Submenu 
Tools Submenu 
Window Submenu 



Blocks Submenu
This submenu provides items for selecting and manipulating text blocks.    For more information, click one 
of the fields on the submenu.



Open/Close Selection
This either opens or closes and existing selection.    See also the Close Block Selection command.



Edit Submenu
This submenu provides items for copying, cutting, pasting text and other related operations.    For more 
information, click one of the fields on the submenu.



Files Submenu
This submenu provides items for opening and saving files and other related operations.    For more 
information, click one of the fields on the submenu.



History of Previously Opened Files
This is a history of previously opened files.    It is limited to the last five files opened and does not include 
files currently opened as buffers.



Go To Submenu
This submenu provides items for moving around the edit buffer and other related operations.    For more 
information, click one of the fields on the submenu.



Help Submenu
This submenu provides items for invoking certain help pages and other related operations.    For more 
information, click one of the fields on the submenu.



Help Contents or Index
This option presents the table of contents for the Editron help system.



Keyboard Help
This option presents a summary of the keystroke commands in the standard Editron keymap.



Menus Help
This option explains the Editron menus.



Dialogs Help
This option explains Editrons dialog boxes.



Tool Bar Help
This option explains the Editron tool bar.



Commands Help
This option shows all the Editron commands and explains each one.



Using Help
This option tells how to navigate the Editron help system.



SDK Help
If you have a Software Development Kit, this option presents its help system.



About Editron
This option displays the About Editron Dialog box.



Macro Submenu
This submenu provides items for managing keystroke macros and other related operations.    For more 
information, click one of the fields on the submenu.



Options Submenu
This submenu provides items for configuring Editron colors, fonts, configuration and other related 
operations.    For more information, click one of the fields on the submenu.



Search Submenu
This submenu provides items for searching and replacing text strings and other related operations.    For 
more information, click one of the fields on the submenu.



Tools Submenu
This submenu provides items for invoking compiler, linking, and other tools.    For more information, click 
one of the fields on the submenu.



Window Submenu
This submenu provides items for tiling windows, arranging icons and other related operations.    For more 
information, click one of the fields on the submenu.



List of Windows & Buffers
This displays all windows with their associated buffers.    Select one to make it the active window for 
further editing operations.



Hidden Window
This is a hidden window with it's associated buffer.    If this is selected then the window will become visible
and be the active window for further editing operations.




